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CE Mandated Warnings 
 

        
Please read the following instructions carefully to prevent potential shock or fire hazards.  This 
manual should be retained for future use. 

        
Bitte lesen Sie die nachstehende Anleitung sorgfältig durch um Stromschlag und Feuergefahr zu 
vermeiden.  Diese Betriebsanleitung sollte für späteren Gebrauch sorgfältig aufbewahrt werden. 

        
Preghiamo di leggere accuratamente, le sequenti Instruzioni, per evitare Prossiomi Incendi e 
Correnti. 

1.              

Shock Hazard – Do Not Enter 

Achtung Hochspannung – Nicht Berühren 
Attenzione Corrent-Forte – Prego non toccare 

2.   
The front panel’s switch is not the power disconnect device.  The power cord should be removed 
after use. 
Der Kippschalter an der Vorderseite unterbricht nicht die Stromzuführung.  Das Stromkabel sollte 
nach Gebrauch aus dem Gerät herausgezogen werden. 
L’interutore nella parete frontale non blocca le Corrente.  La Corrente viene. 

3.   
Never expose the unit to water or liquids.  Avoid direct sun. 
Bringe das Gerät nicht mit Wasser oder einer anderen Flüssigkeiten in Berührung.  Vermeide 
direkte Sonneneinstrahlung. 
Evitare contatto con acqua oppure liquidi Infiammabili al Macchineggio.  Auche entrate di Sole. 
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4.   
Do not insert any objects into the unit. 
Keinen Gegenstand in das Gerät einbringen. Do non inseriamo any obietta into gli unità. 
Non mettere ogetti dentro la Macchina. 

5.   
Do not use near open flame or heat. 
Das Gerät nicht in der Nähe einer offenen Flamme oder Hitze benutzen. 
Non mettere la Macchina vicino a fuochi oppure Riscaldamenti. 

6.   
The unit should never be enclosed or blocked. 
Das Gerät darf nicht eingeschlossen oder blockiert werden. 
La Macchina non chinderla per nessun motivo. 

7.   
Connect unit only to a properly measured supply.  Use only three wire cord which is provided 
with the unit. 
Schließen Sie das Gerät nur an eine ordnungsgemäss vermessene  Stromsversorgung an.  
Verwende nur ein dreiadriges Kabel, wie es auch mit dem Gerät ausgeliefert wird. 
Montare solo con misura normata.  Adoperando solo 3 cavi elettrici cosi come e fornita la 
Macchina. 
 



 

iv  

Filmetrics, Inc. Software License Agreement 
BY COMMENCING USE OF THIS PRODUCT YOU AGREE TO BECOME BOUND BY THE TERMS 
AND CONDITIONS OF THIS AGREEMENT. 

LICENSE 
This license agreement (“license”) permits you to use one copy of FILMeasure (“Software”) on any single computer.  The 
Software is owned by Filmetrics, Inc. ("licensor") and is protected by United States copyright law and international treaty 
provisions.  Therefore, this software should be treated as any other copyrighted material except that you may either: (1) 
make one copy of the Software for archival backup purposes, or (2) copy the Software to a single hard disk.  If the 
Software is used on a networked computer system where more than one computer can access the Software provisions must 
be made to insure that the number of concurrently executing copies of the Software cannot exceed the number of licenses. 

You may transfer the Software and all rights under this Agreement to another party together with a copy of this Agreement 
if the other party agrees to accept the terms and conditions of this Agreement.  If you transfer the Software, you must at the 
same time either transfer all copies (including any prior versions) in any form to the same party or destroy any copies not 
transferred. 

RESTRICTIONS 
You may not use, disclose, copy, modify, rent, lease, loan, resell, network or transfer the Software, or any copy, 
modification or merged portion thereof, in whole or in part, except as expressly specified in this Agreement.  You agree not 
to decompile, reverse engineer, disassemble or otherwise reduce the Software to a human perceivable form. 

SOURCE CODE 
If source code to the Software was supplied to you, then you may modify and use that source code in place of the 
executable version of the Software, but no further rights to distribution or use are granted. 

TERM 
This Agreement is effective until terminated.  You may terminate it at any time by destroying the Software together with all 
copies, modifications and merged portions in any form.  This Agreement will immediately and automatically terminate 
without notice if you fail to comply with any term or condition of this Agreement.  You agree upon termination to promptly 
destroy the Software together with all copies in any form. 

GOVERNMENT LICENSEE 
If you are acquiring the Software on behalf of any unit or agency of the United States Government, the following 
provisions apply: 

The Government acknowledges the licensor’s representation that the Software and its documentation were developed at 
private expense and no part of them is in the public domain.  The Government acknowledges the licensor’s representation 
that the Software is “Restricted Computer Software” as that term is defined in Clause 52.227-19 of the Federal Acquisition 
Regulations (FAR) and is “Commercial Computer Software” as that term is defined in Subpart 227.471 of the Department 
of Defense Federal Acquisition Regulation Supplement (DFARS). 

EXPORT LAW ASSURANCES 
You acknowledge and agree that the Software is subject to restrictions and controls imposed by the United States Export 
Administration Act (the “Act”) and the regulations thereunder.  You agree and certify that neither the Software nor any 
direct product thereof is being or will be acquired, shipped, transferred or re-exported, directly or indirectly, into any 
country prohibited by the Act and the regulations thereunder or will be used for any purpose prohibited by the same. 

GENERAL 
This Agreement will be governed by the laws of the State of California.  You acknowledge that you have read this 
Agreement, understand it and agree to be bound by its terms and conditions.  You further agree that it is the complete and 
exclusive statement of the agreement between us which supersedes any proposal or prior agreement, oral or written, and 
any other communications between us in relation to the subject matter of this Agreement. 

Filmetrics, Inc. Limited Liability Statement 
In no event will Filmetrics, Inc. be liable for any damages or expenses, including any lost profits, lost savings, or other 
incidental or consequential damages arising or associated with the use of, misuse of, or inability to use its products. 
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1 Getting Started 
What is the F20 used for? 

The Filmetrics F20 is used to measure the thickness and optical 
constants (n and k) of dielectric and semiconductor thin films.  Measured 
films must be optically smooth and within the thickness range set by the 
system configuration requirements specified in Appendix B, Performance 
Specifications.  Commonly measured films include semiconductor 
process films such as oxides, nitrides, resists, and polysilicon, optical 
coatings such as hardness and anti-reflection coatings, flat panel display 
films such as polyimides, resist, and cell gaps, and the various coatings 
used in CD and DVD manufacture.  Films that cannot be measured 
include very rough films and metal films. 

 

* * Note * *  Most of this manual, plus additional user information, is 
located in the FILMeasure software help.  Select 
Help>FILMeasure Help… from the menu bar. 

 



 

2 Installation  

Installation 
The following steps assume that the F20 system, cables, and accessories 
have been unpacked and that you have a Pentium-based (100 MHz or 
greater) computer with a Windows 98 or later operating system and a 
USB or parallel port. 

* * Note * *  Windows NT computers do not support USB and must 
use the parallel port F20 system electronics.  

Installation Note for European countries: 
Change the computer’s regional settings to use decimal points. 

Step #1: Install software 
Insert the supplied CD into the CD drive and run setup.exe to install the 
software.  If a floppy disk was supplied, install the files on this disk only 
after the FILMeasure software from the CD has been successfully 
installed.  The floppy disk contains custom software settings pertinent to 
your measurement application or system configuration. 

Step #1: Connect the F20 Spectrophotometer to the Computer 
With the computer power off and the power cord to the F20 
spectrophotometer unplugged, connect the F20 to a USB or parallel port 
of the computer with the supplied cable. 

Step #2: Connect power to the F20 

 

Plug the F20 spectrophotometer into a 100-240 VAC ~ outlet with the 
supplied cable.  Power to the light source is controlled by the front panel 
switch. 

Step #3: Test software 
From the Start menu on the taskbar, select Programs and then select 
FILMeasure to begin program execution.  If a “No Spectrometer 
Detected” message is issued, check that the power cord and interface 
cable are connected correctly. If using a parallel port connection, verify 
that no other programs or drivers conflict with the parallel port. If the 
computer is a desktop PC, a plug-in ISA parallel port card should be 
added and used for the F20.  Contact Filmetrics for further assistance. 

Step #4: Connect Fiber-Optic Cable to the F20 
Follow the instructions on the following pages for setting up your 
particular measurement hardware: 
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System Setup 
Several accessories are available for the F20 series systems. Please refer 
to the following list to find different applications for the configuration 
provided with your system. If you would like information on purchasing 
additional accessories not included, please contact Filmetrics.  

 Fixed Stage (SS-1): The SS-1 stage is our standard stage for the 
F20 system. This is the most versatile stage, which is shipped with 
each system unless otherwise specified. 

 Rotating Sample Stage (WS200, WS300): This stage allows for 
rotation for manual thickness mapping. 

 Small Spot Stage (SS-2): The SS-2 stage is used to achieve a 
smaller spot size for measurement. This is also useful for nonuniform 
or rough samples. This accessory comes standard with the F20-XT 
system. 

 Contact Probe (CP-1): The contact probe is useful for measuring 
coatings on curved surfaces, such as ophthalmic lenses. This accessory 
comes standard with the F20-HC, in place of the SS-1. 

 Contact Probe for Cylindrical Samples (CP-C): This contact probe 
is used for measuring coatings on cylindrical samples, such as test 
tubes and rods. 

 Contact Stage Option (CS-1 Option): The contact stage option is 
used to measure the thickness of freestanding films and coatings on 
glass samples where eliminating the backside reflection of the glass is 
necessary. Use of the contact stage requires that the sample be flat. 

 Transmission Option (T1 Option): This option is used to make 
transmission measurements for transparent samples. 

 Reduced Kinematic Mount with lens assembly (LA1-RKM): This 
assembly is used for inline applications, or when a longer working 
distance in required. 



 

4 System Setup  

If using fixed (SS-1) or rotating (WS-200, WS-300) sample stage: 
Connect the fiber-optic cable between the F20 front panel and the stage 
as shown in Figure 1.1.  The fiber-optic cable should be fully inserted 
into the arm on the stage.  The screw on the end of the stage arm is 
actually a spring-loaded ball plunger, and does not require tightening. 

 
Figure 1.1: Setup Configuration for SS-1 stage. 

 

The fiber-optic cable contains 7 fibers – a single detection fiber 
surrounded by 6 illumination fibers.  The measurement spot size is not 
the illuminated area, but rather the intersection of the illuminated area 
with the projected image of the detection fiber.  When focused for 
maximum signal, the measurement spot size is roughly half the diameter 
of the illuminated area.  The SS-1 sample stage is already optimized for 
maximum focus when the fiber is fully inserted into the stage arm. 
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If using the Small-Spot sample stage (SS-2): 
Connect the fiber-optic cable between the F20 front panel and the stage 
as shown in Figure 1.1.  If the fiber does not have a white label 
indicating “Light Source”, then the two fiber ends are identical, so they 
can each be attached to either the light source or spectrometer Start 
with the fiber-optic cable fully inserted into the arm on the stage.   

Instructions for focusing for maximum signal are as follows: 

a. Turn on the light source and start the FILMeasure program. 
b. Go to the Set Up>Data Acquisition dialog box from the menu 

bar.  Set the integration time for 50 milliseconds, and make sure 
Subtract Dark and Use Reference are de-selected. 

c. Select Acquire>Start Continuous Acquire… from the menu 
bar. 

d. Place a reflecting sample, such as a silicon wafer, at the sample 
position.  You should now see a trace on the screen.  If the 
signal saturates, reduce the integration time (see step b). 

e. Optimize the focus to maximize the measured signal by 
adjusting the fiber-optic cable position in the stage arm.  To 
achieve this, move the fiber-optic cable slightly up the lens tube 
until maximum signal is obtained.  When finished, tighten the 
setscrew that secures the fiber.   

f. The set up is now complete.  Now select Acquire>Stop 
Continuous Acquire…. 
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If using Contact Probe (CP-1): 
Connect the Contact Probe to the F20 front panel as shown in Figure 
1.2.  The two fiber ends leading from the Contact Probe are identical, so 
they can each be attached to either the light source or spectrometer. 

 
Figure 1.2: Setup Configuration for Contact Probe. 
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If using Contact Stage (SS-1 with CS-1 option): 
Connect the contact stage fiber optic cable to the F20 front panel as 
shown in Figure 1.3.  The two fiber ends leading from the common end 
of the fiber are identical, so they can each be attached to either the light 
source or spectrometer.  Connect the four 3” legs to the bottom of the 
SS-1 Sample Stage.  Remove the tilted mirror insert in the SS-1 stage 
using the supplied 1/16” hex socket driver.  Screw the fiber optic cable 
common end into the black contact adapter, and then fully insert the 
contact adapter into the bottom hole in the SS-1 stage, fastening it with 
the 1/16” hex driver. 

 
Figure 1.3: Setup Configuration for Contact Stage. 
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If using Transmission Option (SS-1 with T-1 option): 
Connect the fiber-optic cable between the F20 front panel and the stage 
as shown in Figure 1.4.  The fiber-optic cable should be fully inserted 
into the arm on the stage.  The screw on the end of the stage arm is 
actually a spring-loaded ball plunger, and does not require tightening.  
Connect the four 3” legs to the bottom of the SS-1 Sample Stage.  
Remove the tilted mirror insert in the SS-1 stage using a 1/16” hex 
socket driver.  Screw one end of the single fiber optic cable into the 
black adapter, and then fully insert the adapter into the bottom hole in 
the SS-1 stage, fastening it with the 1/16” hex driver.  Before taking a 
baseline measurement, be sure to set the mode of operation to 
transmittance.  See Chapter 3 Making Measurements, Example #6 for 
more information on transmittance measurements. 

 
Figure 1.4: Setup configuration for T-1 Transmission option. 
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If using Reduced Kinematic Mount with lens assembly (LA1-RKM): 

Step #1: Connect Fiber-Optic Cable to the F20 
Connect the fiber-optic cable between the F20 front panel and the LA1-
RKM as shown in Figure 1.5.  Slide the fiber-optic cable part way into the 
lens assembly.  The spring-loaded setscrew should be adjusted so that 
the fiber-optic cable is held in place, yet it may be moved in and out for 
focus adjustments.  

 
Figure 1.5: Setup configuration for LA1-RKM lens assembly. 

Step #2: Adjust the lens assembly: 
This step involves adjusting the focus and tilt of the lens assembly for 
maximum signal and assumes that the lens assembly has been mounted 
on a fixture approximately 6 inches above the sample surface, and the 
“read” return fiber from the lens assembly to be adjusted is connected to 
the spectrometer input.  The idea here is to adjust the tilt and focus for 
maximum signal.  To do this, 

a. Turn on the light source with the front panel switch and start the 
FILMeasure program. 

b. Go to the Set Up>Data Acquisition… menu item.  Set the 
integration time for 100 milliseconds, and make sure the Subtract 
Dark and Use Reference checkboxes are de-selected. 
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c. Select Acquire>Start Continuous Acquire from the menu bar. 
d. The fiber-optic cable contains 7 fibers – a single detection fiber 

surrounded by 6 illumination fibers.  Do a rough focus adjustment by 
placing a diffuse surface (a business card works well) at the sample 
position and then focus the light beam on the sample position by 
sliding the fiber-optic cable inside the lens tube.  (The diffuse 
reflector will allow you to see the beam.)  When 6 individual spots 
can be seen, slide the fiber-optic cable farther into the LA1-RKM until 
the spots merge into the center of the illuminated area. 

e. Place a reflecting sample, such as a silicon wafer, on the sample 
stage, under the lens assembly.  You should now see a trace on the 
screen.  Turn the tilt adjustment screws to maximize the signal.  If 
the signal saturates, reduce the integration time (see step b). 

f. Optimize the focus to maximize the measured signal by adjusting the 
fiber-optic cable position in the lens assembly.  Focus the light beam 
on the sample by sliding the fiber-optic cable inside the lens tube.  
To see the beam, it may be necessary to place a diffuse surface, 
such as a business card, over the sample.  Ideally, the best focus 
adjustment is when the beam is just under focused.  To achieve this, 
focus the beam on the reflecting sample, and then move the fiber-
optic cable slightly down in the lens tube until maximum signal is 
obtained.  When finished, tighten the socket head set screw that 
secures the fiber.  Once again, if saturation occurs, it may be 
necessary to reduce the integration time. 

g. Repeat steps e) and f) to make certain the adjustments are optimal. 
h. The set up is now complete.  Now select Acquire>Stop 

Continuous Acquire from the menu bar. 
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2 Software Overview 
The way that light reflects off of a thin film is determined by the 
characteristics of the film, such as its thickness, optical constants, and 
roughness.  The F20 is able to determine thin-film characteristics by first 
carefully measuring the amount of light reflected from the thin film over 
a range of wavelengths (i.e., by measuring the reflectance spectrum), 
and then analyzing this data by comparing it to a series of calculated 
reflectance spectra.  Most of the features of the FILMeasure software 
that runs the F20 can be divided into reflectance acquisition and 
reflectance analysis functions.  The following pages outline the main 
features of the FILMeasure software. 

The basic steps for any F20 measurement are selecting and editing the 
film structure, taking a baseline measurement, and then making and 
evaluating the measurement.  The details of each of these steps are 
explained below, followed by descriptions of other FILMeasure functions. 

FILMeasure Main Window 
 

 

 
 
 

1. Standard Windows File menu for saving and retrieving data, 
printing, etc. 

2. The Edit menu is used for viewing and editing the material library. 

1 2 3 4 5 

6 

7 

8 

9 

10 

11 

12 

13 

14 15 



 

12 FILMeasure Main Window  

3. Used to set up reflectance acquisition parameters and the graphic 
display. 

4. For starting and stopping continuous reflectance acquisition and data 
measurement.  Convenient for setting up hardware. 

5. Graphical display for measured and calculated reflectance, as well as 
measured optical constants.  Change display limits by double-clicking 
in the display area.  A click of the right mouse button while the 
curser is within the graphical display activates a blue line (one click 
for measured curve) and red line (2 clicks for calculated curve) for 
easy reading of cursor values in the main FILMeasure window.  
Keyboard up/down and right/left arrows move the line to a desired 
location. 

6. The measured film thickness is displayed here. 
7. The baseline measurement sequence, which is required before 

measurements are made, is initiated by pressing the Baseline 
button. 

8. This button causes a reflectance spectrum to be acquired and then 
analyzed in one step. 

9. Performs analysis on the displayed reflectance spectrum.  Usually 
used when trying different analysis settings on a previously acquired 
spectrum. 

10. Used to select the film structure that is to be measured. 
11. This is where the selected film structure is described, and the 

analysis parameters are set. 
12. Used to select the information displayed in the results box below. 
13. The results box summarizes the most recent measurement results. 
14. Statistical tabulation of all measurement results is accessed by 

pushing this button. 
15. Complete calculated results of the most recent measurement are 

accessed by pushing this button. 
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Edit Structure Window 

 

 

 

A structure defines the film to be measured, the substrate and any 
underlying films, the approximate thickness of the film, and the 
quantities to be measured: 

1. The name of the film structure is listed here. 
2. Advanced measurement parameters can be accessed by clicking on 

the Solver Options tab. 
3. Constraints on the possible measured values are selected here. 
4. Used to set alarms to notify the user of measurements that are 

outside of a user-specified thickness range or have a poor GOF. 
5. Author, as defined by user login name and structure modification 

date are indicated here. 
6. A very robust thickness measurement routine is enabled by selecting 

this box. 
7. Another very robust thickness measurement routine used for 

measuring very thick films or thick multi-layer stacks, where the total 
thickness is greater than 5 microns. See Fast Fourier Transform 
Thickness Only Mode (FFT TO mode) on page 47 for more 
information. 

8. The values to be measured are selected by checking the appropriate 
boxes. 
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9. OK closes the Edit Structure box, retaining any changes made.  
Changes will not be permanently saved unless Save or Save As is 
selected.  The Cancel button closes the Edit Structure box without 
retaining changes. 

10. Known film roughness for films not being measured, and the initial 
guess for the film(s) being measured are entered in this column. 

11. Known film thicknesses for films not being measured, and the initial 
guess for the film(s) being measured are entered here. 

12. The structure can be saved as a new structure, deleted, or changes 
can be saved. 

13. The film layers are listed here.  Common films can be selected from 
the pull-down menus. 

14. Layers can be added or deleted using these buttons.  Up to 8 layers 
may be present in the structure. 

15. The thickness (length) units are chosen here.  The choices include 
nanometers (nm, 10e-9 m), microns (µm, 10e-6 m), angstroms (Å, 
10e-10 m), and kilo-angstroms (kÅ, 10e-7 m). 
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Taking a Baseline 
The baseline measurement allows the FILMeasure software to take into 
account the response inherent to the F20 reflectance measurement 
hardware.  It does this by measuring a reference sample and by taking a 
“dark” reading.  If optical constants or very thin films (< 1000 Å) are to 
be measured, the light source should be allowed to stabilize at least ten 
minutes before the baseline is taken, and then periodically re-taken 
every 20-30 minutes.  For thicker films, a new baseline can be taken less 
often. 

Baseline measurements may be started two ways: 

1. Select the Baseline button in the main FILMeasure window, 
which will guide the user through the baseline procedure, or 

2. Select Set Up>Data Acquisition from the menu bar for 
manual access to the baseline functions. 

The first step of the baseline measurement is to take a reference 
spectrum.  This done by placing a reference sample of similar reflectance 
to the test sample (usually silicon or BK7 glass) on the sample stage and 
clicking OK when prompted.  The reference material that is used should 
be selected from the Reference list.  For reference materials not in the 
list, reflectance versus wavelength values should be entered into a text 
file with the extension “.rrr” (stored in the Material subfolder). 

The dark scan should be taken with no sample on the stage and the light 
turned on (so that the light output remains stable).  Most stages have a 
built-in tilted mirror or other reflector that is used to re-direct the 
incident light away from the collection optics.  If you are using a 
movable stage, move this reflector under the light beam.  Click on OK to 
take the dark reading. 

After acquiring a baseline the F20 is ready to begin making 
measurements.  To verify that the system is working properly, you may 
select Acquire>Do Single Acquisition from the menu bar, with the 
reference sample in place.  You should see the reflectance spectrum of 
the reference material. 

Editing Film Structures 
The description of the nominal film structure, as well as the 
measurement parameters, is specified in the Edit Structure dialog box.  
Dozens of different film structures and their measurement specifications 
may be saved using the Edit Structure dialog box. 

The Edit Structure dialog box is accessed with the Edit Structure 
button on the right-hand side of the main FILMeasure window.  The Edit 
Structure dialog box lists an initial guess at the specifications of the 
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film structure to be measured.  These specifications include the name of 
the film structure (which identifies it in the Structure: list), the number 
of films in the structure, the specifications of individual films, and the 
quantities to be measured. 

Edit Structure > Adding, Changing, or Deleting a Structure 
When the Edit Structure dialog box is opened, it shows the stored 
specifications of the structure selected from the Structure: list, along 
with any changes made since the program was started.  Changes to the 
structure selected can be permanently stored by making the desired 
changes and then clicking on Save.  New structures may be added to 
the Structure: list by opening the Edit Structure dialog box, setting 
the desired specifications, and then clicking on Save As.  Similarly, a 
structure may be deleted (removed from the Structure: list) by clicking 
on Delete Structure.  

 

Figure 2.1:  Edit Structure>Layers window. 

Edit Structure > Layers: Setting Up a Film Structure 
When measuring a layer, the specifications (d, n, k, roughness) of the 
known films (including the incident medium and substrate) must be 
entered into the proper fields in the Edit Structure dialog box, as well 
as initial guesses for the values to be measured.  The refractive index 
(n) and extinction coefficient (k) values for common materials can be 
selected automatically with the pull-down menus on the left-hand side of 
the Edit Structure dialog box. 

If a material is being measured which is not present in the pop-up 
material list there are three possible approaches: a) choose a material in 
the list which is similar, b) if the material is transparent, select “Enter 
Refractive Index Value” from the material list and enter a value for 
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the refractive index (n will automatically be varied by FILMeasure to 
account for dispersion effects, with the entered value being n at 632 
nm), or c) in the Edit>Material Library… dialog box from the menu 
bar, enter the refractive index values for n and k as a function of 
wavelength and save the files so that they may be selected as in a).  See 
page 23 for more information. 

Edit Structure > Layers: Measuring Thickness 
To measure a film thickness, check the appropriate box on the right-
hand side of the Layers field in the Edit Structure dialog box.  When no 
boxes are checked, and Analyze (or Reanalyze) is selected from the 
main FILMeasure window, the theoretical spectrum for the specified 
layer structure and thicknesses will be displayed. 

Edit Structure > Layers: “Enable Robust Thickness Only” 
If thickness, of films greater than 1000 Å, is the only property to be 
measured, then the Enable Robust Thickness Only mode is 
recommended.  This mode can oftentimes allow for successful 
measurements to be made when the reflectance data is affected by non-
ideal film properties, such as non-uniformities and birefringence.  The 
range of thicknesses tested is constrained by the limits set in the 
Constraints field in the Constraints tab.  Selecting this feature will 
limit the Options tab settings available. 

Edit Recipe > Layers: Enable FFT Thickness Only 
If thickness, of films greater than 5 microns, is the only property to be 
measured, then the Enable FFT Thickness Only mode is 
recommended. This mode is oftentimes the most effective technique 
when the sample has multilayer stacks. Selecting this feature will limit 
the Options tab settings available. 

Edit Structure > Solver Options 
Correct setting of the following options will help ensure accurate 
measurements.  Many of the options are set automatically when film 
information is supplied in the Edit Structure dialog box, and all of them 
can be saved so that subsequent measurements can be made as quickly 
and easily as possible. 
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Figure 2.2:  Edit Structure>Options window. 

Edit Structure > Solver Options: Grid search for thickness 
There are a number of methods that FILMeasure can use to determine 
thickness.  None is perfect – each is a different trade-off between speed, 
accuracy, and robustness (i.e., the ability to find the best solution among 
many that are nearly as good).  Because thickness can vary over many 
orders of magnitude and many near-solutions exist, it is often best to 
use a very robust method to get close to the best solution, and then let 
a more accurate method take over.  One very robust method is the Grid 
method, which can be activated by selecting the Grid search for 
thickness checkbox.  The Grid method searches the entire allowed 
thickness range (as defined by the initial guess and the constraints) to 
find the best initial thickness.  However, on some very complex 
multilayer spectra, it is possible for the Grid method to become confused 
and give the wrong answer.  In such cases it is best to use the Fourier 
Transform method to determine initial thicknesses (see below), or to 
provide them manually.  

Edit Structure > Solver Options: Fourier search for thickness 
The Fourier search for thickness checkbox is an alternative option to 
let FILMeasure choose an initial thickness for analysis.  The Fourier 
Transform method analyzes the oscillations present in the spectrum and 
determines the film thicknesses based on the periodicity of those 
oscillations.  It is somewhat less robust than the Grid method, but is 
better at finding the correct thickness in cases where the shape of the 
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initial theoretical spectrum is different than the measured data (i.e., the 
reflectance spectrum is non-ideal in some way) or in cases where there 
is more than one film thickness is being measured. 

Edit Structure > Solver Options: Account for Back Reflections 
When measuring films in transparent substrates, reflectance off of the 
backside of the substrate may occur. Account for Back Reflections 
allows the software to shift the intensity of the reflectance curve to 
account for the additional light. This feature should not be used when 
measuring very thin films (< 100 nm). 

Edit Structure > Solver Options: Account for Non-Planarity 
Samples with nonplanar surfaces scatter some of the light away from the 
collection optics. This option automatically compensates for the light lost 
due to nonplanarity. 

Edit Structure > Solver Options: Convergence Criteria 
This sets the minimum GOF between the measured and calculated 
spectra that is attained before the measurement routines consider the 
solution final.  In most cases a value of 0.999 is sufficient.  For cases 
where the desired GOF is not attainable, the value in the Maximum 
Iterations field limits the number of iterations performed by the 
analysis routine. 

Edit Structure > Solver Options: Measurement Type 
Specify here whether the data to be analyzed is Reflectance or 
Transmittance.  

Edit Structure > Solver Options: Analyzed Data 
This sets the range of data that is to be analyzed. It may be either the 
range displayed on the current graph or a fixed range. 

Edit Structure > Solver Options: Lock Identical Layers 
Samples comprised of repeating layers can be more accurately measured 
by activating this option. Once the option is active, all properties of any 
layers that initially have the same material and thickness are locked 
together. 
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Figure 2.3:  Edit Structure>Solver Constraints window. 

Edit Structure > Solver Constraints 
By setting constraints, the user can limit the possible values of the 
measured film properties.  The constraints are set in conjunction with 
the values entered in the Edit Structure>Layers dialog box.  For 
example, if the initial guess of the measured thickness of a film is 1000 Å 
and the thickness constraint is set at ±50%, FILMeasure will only 
consider possible thicknesses in the range 500 Å to 1500 Å.  
Constraining the measurement range can speed up the measurements 
and can also help exclude non-physical solutions. 
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Figure 2.4:  Edit Structure>Alarms window. 

Edit Structure > Alarms: Activate Alarms 
When Activate Alarms is selected, an alarm will trigger if the measured 
thickness of the sample is outside the specified Thickness Limits. 

Edit Structure > Alarms: Thickness Limits 
Setting the minimum and maximum allowable thickness limits will trigger 
an alarm if the measured thickness is outside the limits when Activate 
Alarms is selected. 

Edit Structure > Alarms: GOF Error 
Constraining the GOF Error will exclude measurements where the 
calculated GOF does not reach the specified limit.  A warning or 
“Invalid” result will appear if the GOF constraint is not met.  Specify 0 
to have all solutions reported.  More information on GOF may be found 
on page 22. 

Understanding and Evaluating Measurement Results 

Display of Measured Data 
Once film structure and measurement information have been entered 
and baseline spectra taken, measurements may be made by clicking on 
the Measure button.  After measurement, the measured and calculated 
reflectance spectra are displayed on the graph.  The thicknesses of the 
films are listed in the results box.  If any of the thickness values were 
measured, they are displayed in bold numbers. 
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The values of the calculated reflectance versus wavelength are listed in 
the grid that is viewed by clicking on the Show Table button at the 
lower right-hand corner of the screen.  The calculated n and k values 
may be viewed by scrolling through the grid.  Clicking on a column 
containing measured data will cause it to be plotted on the graph. 

Selected data from the results grid may be copied to the clipboard by 
clicking on the Copy Selected Data button.  The wavelength data is 
copied along with the selected reflectance, n, and/or k data. 

Goodness of Fit (GOF) 
The accuracy of a calculation fit, and thus the reliability of the 
measurement, can be judged by the match between the measured and 
calculated spectra, which is quantified by the GOF value.  GOF is a 
number between 0 and 1.  0 is a poor fit.   

A perfect match between measured (blue) and theoretical (red) spectra 
will result in a GOF of 1.0. To ensure accurate results the user may set a 
minimum acceptable GOF value by entering a number between 0 and 1 
into GOF Error on the Constraints Tab in Edit Recipe. A warning 
message will be displayed after each measurement where the GOF falls 
below the user-specified GOF Error. If the GOF is less than 1.0 there 
are several possible causes as follows: 

 a) Nonuniformity – Any variation of layer thickness, or presence 
of roughness, within the measurement spot will result in a reduction in 
reflectance.  In severe cases the interference peaks may disappear 
entirely. 

 b) Incorrect Structure Definition – If the refractive index of one 
or more layers in the structure is different from what is described in the 
layer structure, there may be some mismatch between the blue curve 
and the red curve. 

 c) Graded Interfaces – The amplitude of the peaks in the 
spectrum depends on both the size of the change in refractive index at 
each interface in the layer structure and the sharpness of the interface. 
In many hardcoat samples you will find that there is some degree of 
layer intermixing at the interface, leading to a weaker than expected 
reflectance at that interface. In severe cases the peaks may disappear 
entirely. 

Window Menu Items 

File > Open Reflectance Spectrum… 
This command is used to open stored reflectance spectra, which are 
then displayed and can be analyzed for film properties. 
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File > Save Measured Spectrum… 
This command is used to save measured reflectance spectrum for export 
or later analysis.  All data is saved along with the corresponding 
wavelength data in comma-delimited format. 

File > Save Calculated Spectrum… 
This command is used to save the calculated reflectance spectrum for 
export or later analysis.  All data is saved along with the corresponding 
wavelength data in comma-delimited format. 

Edit > Material Library… 
The files that FILMeasure uses to describe n and k of different materials 
can be edited and created by selecting Edit>Material Library… from 
the menu bar.  The files that are used to describe n and the material 
type (e.g., dielectric, semiconductor, metal) are designated index files 
and have the extension “.nnn”.  The files that describe k have the 
extension “.kkk”. 

 
Figure 2.5:  Edit>Material Library… dialog box. 

A new material may be entered into the material library using manually if 
refractive index (n) and extinction coefficient (k) are known as a function 
of wavelength for the new material, they may be manually added to the 
library.  For each material there is a file that contains index values as a 
function of wavelength.  This file is named material.nnn.  Optionally, a 
.kkk file may be created.  If no .kkk file is created, k is assumed to equal 
zero over the entire spectrum. To create a new material file: 

a. Select Edit>Material Library… menu item.  The Edit 
Material dialog box will appear.  

b. Click New… to create a new material.  
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c. Select the type of file and type of material you are ready to 
create (.nnn or .kkk).  

d. Optimize the functionality of the file by entering index values 
over the entire wavelength spectrum of the system.  The 
wavelength unit is nanometers.  Enter index information every 
20 to 50 nm, depending on the complexity of the data.  In areas 
where n or k is quickly changing, more densely spaced the 
points should be entered.  

e. Alternatively, select on the Model>Custom option button and 
click the Model button. A Custom Model Information dialog 
box will appear.  Select the appropriate model.  Enter in the 
known coefficients and click OK.  Cauchy coefficients are 
displayed in microns.  If they are entered in Å, FILMeasure will 
automatically detect it and convert them to microns. 

Set Up > Data Acquisition: Integration Time 
This control is used when manually setting the integration time (i.e., 
when not using Auto Integration Time: feature).  To set the 
integration time, make sure that the Subtract Dark and Use 
Reference checkboxes are not selected.  Enter a time into the 
Integration Time (ms) field and click OK.  A value of 100 ms is a 
good starting point.  To facilitate rapid adjustment of the integration 
time, select Acquire>Start Continuous Acquisition from the main 
FILMeasure window menu bar.  FILMeasure will now be continuously 
acquiring and displaying scans.  If the scan is off-scale, select Set 
Up>Graph Options from the menu bar.   Activate AutoScale 
Maximum to rescale the y-axis.  The vertical scale of the spectrum 
extends from zero to 4095.  Thus, a good working level is when the 
peak height of the sample being measured, or the reference sample, 
which ever is greater, is 3000-3500 counts.  (Note: if the reference 
measurement saturates – Detector Saturation error – then spurious final 
measurements will result.)  If the maximum signal is too low, increase 
the integration time.  Too large an integration time will result in 
excessive dark current, so it is sometimes necessary to accept a smaller 
signal level to limit the dark current. 

* * Note * *  If the integration time is changed, it will be necessary to 
re-acquire the dark and reference scans. 
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Figure 2.6:  Set Up>Data Acquisition dialog box. 

Set Up > Data Acquisition: Reference Material 
Enter here the reflectance (or transmissivity if in transmittance 
measurement mode) value of the reference sample used.  For 
transmittance measurements referencing with air, enter 1.0.  For 
reflectance measurements, the reflector should have known reflectance 
characteristics over the region of interest.  The reflectance versus 
wavelength values should be entered into a text file with the extension 
“.rrr” (stored in the FILMeasure\Material subfolder).  Materials that 
already have “.rrr” extensions are available by selecting from the list in 
the Reference Material: field. 

Set Up > Data Acquisition: Take Dark 
This button allows the dark portion of the baseline measurement to be 
taken without having to re-take the reference measurement.  

Set Up > Data Acquisition: Take Reference 
This button allows the reference portion of the baseline measurement to 
be taken without having to re-take the dark measurement.  

Set Up > Data Acquisition: Subtract Dark 
This feature allows the dark subtraction portion of the baseline 
correction to be disabled.  
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Set Up > Data Acquisition: Use Reference 
This feature allows the reference portion of the baseline correction to be 
disabled.  

Set Up > Data Analysis: Data Smoothing 
This function averages together a number of data points on either side 
of each measured data point.  For example, if the Smoothing Points 
field is set to 5 then each data point displayed on the screen is actually 
an average of five data points (the data point plus the two data points 
on either side).  This function can be used to reduce noise when 
reflectance signals are very weak. 

Set Up > Data Analysis: Scans to Average 
In order to get the low noise spectrum it is occasionally necessary to 
acquire a number of reflectance spectra and display their average.  This 
is readily accomplished by setting the Scans to Average field.   

Set Up > Graph Options: Axis Fields 
The Graph Options dialog box may also be accessed by double-clicking 
on the graph display.  The Horizontal Axis Minimum and Maximum 
fields are used to control the wavelength range displayed on the screen.  
Use the Vertical Axis Minimum and Maximum fields to control the 
vertical-axis display.  Check the Autoscale Maximum checkbox to 
activate y-axis autoscaling.  The lower value is always 0 for autoscaling; 
the maximum y-axis upper limit is 5000. 

Set Up > Significant Figures 
Select the number of significant figures for FILMeasure to display, 
between 4 and 7, with a maximum of 0.1 Å resolution. 

Set Up > Reflectance Mode (Transmittance Mode) 
Choose the correct mode of operation before beginning a baseline 
measurement.  The measurement settings are stored for each of the two 
possibilities.  After taking a baseline in reflectance and in transmittance, 
this feature allows for switching between reflectance and transmittance 
with out taking any other baselines. 

Set Up > Contact Probe Mode: Activate 
If using the contact probe (CP-1), enabling the Contact Probe Mode 
allows spectra to be taken and measured continuously while the probe is 
depressed on the sample. Continuous measurement can be stopped by 
pressing the Stop Measurement button or by removing the probe from 
the sample. Once measurement is stopped, a window will appear listing 
the measurements made since contacting the sample. The software will 
automatically highlight the second-to-the-last measurement. If the 
automatically selected measurement is unacceptable, a different 
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measurement can be selected by clicking on it. The acceptability of the 
selected measurement must be confirmed by clicking the OK button or 
by starting another measurement by placing the probe in contact with a 
sample. 

Set Up > Contact Probe Mode: Activate Template Mode 
By selecting Activate Template Mode, the user can edit and measure 
to a user-defined template. For more information on editing and 
measuring templates, go to Contact Probe – Template Mode on 
page 49. 

Set Up > Access Control… 
The software for the F20 incorporates password protection to limit 
access to the measurement software and settings.  When the software is 
initially installed the access control is turned off.  The software will 
automatically boot up with Engineer level access that enables access to 
all features of the program except turning on and off access control and 
adding and deleting users. 

Turning on access control requires Supervisor level access.  The 
software is delivered with one user, a supervisor, in the list of authorized 
users as shown below: 

UserID:  filmsuper 

Password: filmetricsfff 

To turn on access control, log in as filmsuper using the password shown 
above.  The Activate Access Control checkbox should now be 
enabled.  By placing a check mark in the Activate Access Control 
checkbox access control will be active.  User ID and Password are case-
sensitive. 

To add an operator level user, select operator from the Access Level 
list box, type a user name and type an initial password for that user.  
Then click the Add User button.  To add an engineer or a supervisor 
user follow the same procedure, but pick the appropriate access level 
from the list box before pressing the Add User button. 

To Delete a user, enter the UserID and press the Delete User button.  

Operator and Engineer level users can change their passwords when 
they are logged in by entering their password into the password box and 
pressing the change button.  Supervisor-level users can change their 
password or the password of any other user by selecting the appropriate 
access level, entering the appropriate UserID and the new password 
and pressing Add User.  If the program finds that a user already exists, 
it will delete the old entry for that user and create a new entry. 

We recommend that you create a new supervisor level user and delete 
the filmsuper user for maximum security.  If all supervisor level users 
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forget their passwords, it will be necessary to re-install the software and 
add all the users again. 

Set Up > Configuration… 
Users can set this to point to the location of layer structure files. The 
default configuration is set to C:\Program Files\FILMeasure. 

Set Up > Show Measured Spectrum 
Deselect this function to hide the blue (measured) curve from the graph. 

Set Up > Show Calculated Spectrum 
Deselect this function to hide the red or gray (calculated) curve from the 
graph. 

Acquire > Start Continuous Acquire (Stop Continuous Acquire)  
This feature collects real-time data from the spectrometer. It is useful 
when searching for a specific location to measure (for example, locating 
a more uniform area of the sample that exhibits interference fringes). 

Acquire > Start Continuous Measure (Stop Continuous Measure) 
This feature collects real-time spectrum data and analyzes it – similar to 
pressing the Measure button over and over. 

Acquire > Do Single Acquisition 
This function collects a single spectrum, blue curve, without performing 
any analysis. 
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3 Making Measurements 

Types of Measurements 
Accurate measurements with the F20 rely on using the proper 
measurement setup.  The type of setup that is used depends upon 
whether both thickness and optical constants are being measured, or 
just thickness alone.  Also important are the thickness of the film and 
the type of substrate. 

The basic steps for any F20 measurement are: 1) selecting and editing 
the type of film to be measured, 2) taking a baseline measurement, and 
3) clicking on the Measure button to make the measurement.  Each 
example below will take you through this sequence of steps.  In each 
example it is assumed that the hardware has been set up as described in 
Chapter 1 Getting Started, and that you have first read through Chapter 
2 Software Overview to familiarize yourself with the basic controls.   

The “Measurement Assumptions”, “Hints for Improved Accuracy”, and 
“Troubleshooting” sections describe techniques that should be followed 
for the most accurate measurements. 

Examples that describe the most common measurement setups are 
described in this section.  Use Figure 3.1 to find the proper example for 
your application. 
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Note:  Transparent substrates are considered to have a reflective backside unless 

the backside is specially prepared to absorb light incident from the frontside. 

 

Figure 3.1:  Selection tree for identifying the example for specific measurements. 
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Examples 

Example #1:  Thickness of Films Greater Than ½ Micron Thick:  SiO2 on 
Silicon 

For this example we will demonstrate only the measurement of SiO2 on 
silicon (the SiO2 on Silicon Test Sample provided with the F20 may be 
used), but this type of measurement has an extremely broad range of 
applications, including hardcoats, polysilicon, and LCD cell gaps, to name 
just a few. 

Hardware: 
If the sample to be measured is flat, any standard or rotating sample 
stage will work fine.  If the sample is curved, or is transparent with films 
on its backside (such as eyeglass lens applications), a hand-held contact 
probe measurement device (e.g., Part# CP-1) may be necessary. 

Step 1:  Select the film structure 
Select the film structure to be measured, in this case “SiO2 on Si”, from 
the Structure: list box on the main screen.  If the structure to be 
measured does not exist, a new structure must be defined (see “Editing 
Film Structures”). 

Step 2:  Edit the film structure 
To edit the structure, click the Edit Structure button to open the dialog 
box.  Check to see that the film sequence matches that of the actual 
sample.  If not, different films can be selected.  Also enter your best 
guess for the thickness of the film to be measured, and check that only 
the SiO2 layer thickness is being measured. 
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Figure 3.2:  Example Edit Structure>Layers window for measuring the 

thickness of a thin film greater than ½ micron thick. 

Step 3:  Take a Baseline Measurement 
Take a baseline measurement by first clicking on the Baseline button 
on the main screen.  A dialog box will appear to step you through the 
process.  In the Take Baseline dialog box, make certain the Autoscale 
Integration checkbox is selected, and choose the reference material 
that will be used (“Si” in this case).  Then put the reference sample on 
the measurement stage and click OK.  A new dialog box will appear with 
further instructions for the dark measurement: remove the reference 
sample from the stage (or tilt the sample at an angle) and click OK.  (In 
the case of a contact probe, place the probe on the baseline sample and 
click OK, and then remove the probe from the sample and click OK.) 

Step 4:  Make the Measurement 
Make the measurement by placing your sample on the stage (or the 
contact probe on your sample) and click on the Measure button.  
FILMeasure will then acquire the reflectance spectrum and calculate the 
corresponding thickness.  If the measurement was successful, the 
minima and the maxima of the calculated reflectance (the red line on the 
graph) will coincide in wavelength with the minima and the maxima of 
the measured reflectance (the blue line on the graph).  In most cases 
they will not overlap, but will be separated in amplitude. 
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Figure 3.3:  Measured and calculated reflectance spectra when measuring the 

thickness of SiO2 on silicon. 

If the calculated (red) and measured (blue) minima and maxima do not 
coincide, then the measurement was not successful.  There are several 
possible causes of an unsuccessful measurement.  The most common for 
this type of measurement are described in Cases #1, #2, #3, and #4 in 
the “Troubleshooting” section. 
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Example #2:  Thickness of Films Less Than ½ Micron Thick on Thick 
Transparent Substrates:  TiO2 on Glass 

This example demonstrates the measurement of TiO2 on glass.  This 
type of measurement has a broad range of other applications, most 
commonly optical coating and flat-panel display process films. 

Hardware: 
If the sample to be measured is flat, the contact sample stage should be 
used.  If the sample is curved, the hand-held contact probe (e.g., Part# 
CP-1) may be necessary. 

Step 1:  Select the film structure 
Select the film structure to be measured, in this case “TiO2 on Glass”, 
from the Structure: list box on the main screen.  If the structure to be 
measured does not exist, a new structure must be defined (see “Editing 
Film Structures”). 

 
Figure 3.4:  Example Edit Structure>Layers window for measuring the 

thickness of a film less than ½ micron thick on a thick, clear substrate. 

Step 2:  Edit the film structure 
To edit the structure, click the Edit Structure button to open the dialog 
box.  Check to see that the film sequence matches that of the actual 
sample.  If not, different films can be selected.  Also enter your best 
guess for the thickness of the film to be measured, and check that only 
the TiO2 layer thickness is being measured. 
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Step 3:  Take a Baseline Measurement 
Take a baseline measurement by first clicking on the Baseline button 
on the main screen.  A dialog box will appear to step you through the 
process.  In the Take Baseline dialog box, make certain the Autoscale 
Integration checkbox is selected, and choose the reference material 
that will be used (“BK7” in this case).  Then put the reference sample on 
the measurement stage and click OK.  A new dialog box will appear with 
further instructions for the dark measurement: remove the reference 
sample from the stage (or tilt the sample at an angle) and click OK.  (In 
the case of a contact probe, place the probe on the baseline sample and 
click OK, and then remove the probe from the sample and click OK.) 

Step 4:  Make the Measurement 
Make the measurement by placing your sample on the stage (or the 
contact probe on your sample) and click on the Measure button.  
FILMeasure will then acquire the reflectance spectrum and calculate the 
corresponding thickness.  If the measurement was successful, the 
minima and the maxima of the calculated reflectance (the red line on the 
graph) will coincide in wavelength with the minima and the maxima of 
the measured reflectance (the blue line on the graph).  In most cases 
they will not overlap, but will be separated in amplitude. 

 
Figure 3.5:  Measured and calculated reflectance spectra when measuring the 

thickness of TiO2 on glass. 
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If the calculated (red) and measured (blue) minima and maxima do not 
coincide, then the measurement was not successful.  There are several 
possible causes of an unsuccessful measurement.  The most common for 
this type of measurement are described in Cases #1, #2, #3, and #4 in 
the “Troubleshooting” section. 
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Example #3:  Thickness of Films Less Than ½ Micron on Thin Transparent 
Substrates:  MgF2 on Glass Slide 

In this example we will demonstrate the measurement of MgF2 on a 
glass slide. 

Hardware: 
For this type of measurement the sample must be flat, with the front 
and backsides parallel.  The standard SS-1 sample stage is required.  
The contact stage option is recommended.  If you are able to take the 
baseline measurements with an uncoated substrate, then follow the film 
structure setup instructions in Example #2. 

Step 1:  Select the film structure 
Select the film structure to be measured, in this case “MgF2 on Glass”, 
from the Structure: list box on the main screen.  If the structure to be 
measured does not exist, a new structure must be defined (see “Editing 
Film Structures”). 

Step 2:  Edit the film structure 

 
Figure 3.6:  Example Edit Structure>Layers window for measuring the 

thickness of films less than ½ micron thick on a thin transparent substrate. 

To edit the structure, click the Edit Structure button to open the dialog 
box.  Check to see that the film sequence matches that of the actual 
sample.  If not, different films can be selected.  Also enter your best 
guess for the thickness of the film to be measured, and check that only 
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the MgF2 layer thickness is being measured.  The “Enable Robust 
Thickness Only” checkbox should be deselected. 

 
Figure 3.7:  Example Edit Structure>Options window for measuring the 

thickness of films less than ½ micron thick on thin transparent substrate. 

Step 3:  Take a Baseline Measurement 
Take a baseline measurement by first clicking on the Baseline button 
on the main screen.  A dialog box will appear to step you through the 
process.  In the Take Baseline dialog box, make certain the Autoscale 
Integration checkbox is selected, and choose the reference material 
that will be used (“BK7” in this case).  Then put the reference sample on 
the measurement stage and click OK.  A new dialog box will appear with 
further instructions for the dark measurement: remove the reference 
sample from the stage (or tilt the sample at an angle) and click OK.  (In 
the case of a contact probe, place the probe on the baseline sample and 
click OK, and then remove the probe from the sample and click OK.) 

Step 4:  Make the Measurement 
Make the measurement by placing your sample on the stage (or the 
contact probe on your sample) and click on the Measure button.  
FILMeasure will then acquire the reflectance spectrum and calculate the 
corresponding thickness.  If the measurement was successful, the 
minima and the maxima of the calculated reflectance (the red line on the 
graph) will coincide in wavelength with the minima and the maxima of 
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the measured reflectance (the blue line on the graph).  In most cases 
they will not overlap, but will be separated in amplitude. 

 
Figure 3.8:  Measured and calculated reflectance spectra when measuring the 

thickness of MgF2 on a glass slide. 

If the calculated (red) and measured (blue) minima and maxima do not 
coincide, then the measurement was not successful.  There are several 
possible causes of an unsuccessful measurement.  The most common for 
this type of measurement are described in Cases #1, #2, #3, and #4 in 
the “Troubleshooting” section. 
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 Example #4:  Transmittance Measurements  
For this example we will demonstrate the acquisition of a transmittance 
spectrum.  If analysis is to be performed on the measured transmittance 
spectrum, be sure to specify “Transmittance” in the 
Options>Measurement Type section of the Edit Structure dialog 
box. 

Hardware: 
For this type of measurement the sample must be flat, with the front 
and backsides parallel.  The standard sample stage equipped with the T-
1, Transmission Option, is required.  When measuring very thin films, 
use of a vacuum plugged into the vacuum port is recommended. 

Step 1: Specify Transmittance Mode 
Under the Set Up menu, activate Transmittance Mode. 

 
Figure 3.9:  Transmittance Mode Setup 

Step 2:  Take a Baseline Measurement 
Take a baseline measurement by first clicking on the Baseline button 
on the main screen.  A dialog box will appear to step you through the 
process.  In the Take Baseline dialog box, make certain the Autoscale 
Integration checkbox is selected.  In the list box, choose the reference 
sample material that will be used.  Be sure the file represents 
transmittance data.  Place the bare substrate on the stage in the light 
beam and click OK.  

If measuring layers on a very thin substrate (less than 1 mm), select 
“Enter Constant…” and enter “1” to use air as the reference.  Then click 
OK while the beam is unblocked. 



 

Chapter 3 Making Measurements  41 

A new dialog box will appear with further instructions for the dark 
measurement: place an opaque object on the stage to block the beam 
and click OK.  Note: Most glasses and plastics absorb UV light below 350 
nm, displayed as a sudden drop in transmittance at those wavelengths. 

Step 4:  Make the Measurement 
Make the measurement by placing your sample on the stage.  Under the 
Acquire>Do Single Acquisition from the menu bar. 

 
Figure 3.10:  Do Single Acquisition collects the measured spectrum (blue 

curve) off of the sample. 

 
Figure 3.11:  Transmittance spectrum. 
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Measurement Assumptions 
The following assumptions must be valid if accurate measurements are 
to be made with the F20: 

1. Every film present in the structure is specified in the Edit Structure 
dialog box.  This includes every film present in the sample including 
so-called adhesion films, oxide films (unless they are less than 20 Å 
or greater than 500 microns thick), and films on the bottom surface 
of the substrate if the substrate is transparent. 

2. The thickness of the measured film is uniform over the spot being 
measured. 

In addition, the following assumptions are made if optical constants 
and/or very thin films (<500 Å) are to be measured: 

3. Each film in the structure is homogeneous and uniform (i.e. the 
refractive index and extinction coefficient are constant as a function 
of depth and constant over the entire spot being measured). 

4. No significant scattering of the light incident on the sample is 
occurring, unless it is caused be slight surface roughness that is 
being accounted for in the structure definition. 

5. The top surface of the sample under test is at the same height as 
the reference sample that was used to make the reference 
calibration measurement. 

6. The sample is flat.  (The vacuum chuck may help in this case when 
samples are warped.) 

7. No changes to the measurement system (such as fibers moved) or 
light source have occurred since the acquisition of the most recent 
baseline. 

8. The light source has been allowed to warm up for approximately 15 
minutes. 

9. No significant changes in room temperature (> 10 degrees F) have 
occurred since acquisition of the most recent baseline. 

If any of the above assumptions are not true, it may still be possible to 
make a measurement, but accuracy may be degraded. 
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Hints for Improved Accuracy 

Roughness 
Slight amounts of surface or interface roughness may be present that 
will decrease the GOF value for a measurement.  Entering a value for or 
solving for roughness can account for this roughness, so that a better 
GOF may be achieved.  Generally, roughness is only present when the 
sample surface looks hazy at the measurement spot.  The fact that this 
haze can be seen means that there is scattered light.  (A perfectly 
smooth surface will scatter no light, and thus the measured spot will not 
be visible.)  Usually roughness less than 25 Å will not be visible, while 
roughness greater than about 200 Å will be extremely hazy. 

Restricting the wavelength range of the analyzed reflectance spectrum 
Occasionally the reflectance spectrum from measured films is adversely 
affected by factors such as absorbing dyes, birefringence, or non-
uniformity, none of which can be properly modeled.  It may be possible 
to still make accurate thickness measurements of these films by 
analyzing only the portions of the spectra that contain valid, uncorrupted 
thickness information (i.e., oscillations).  The portion of the reflectance 
spectrum that is used to calculate film properties is determined by the 
graphic display, i.e., only the data shown on the screen is used in the 
calculations.  Therefore, to measure values using a restricted wavelength 
range, simply select a narrower range by double-clicking on the screen 
to bring up the Graph Options dialog box.  An example is shown in 
Figure 3.12 and Figure 3.13.   
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Figure 3.12:  Example of non-ideal film (spectrum with no oscillations at lower 

wavelengths) that requires reduced wavelength range for accurate 

measurement. 

 
Figure 3.13:  Example of reduced wavelength range for measuring thickness of 

non-ideal films. 

Measuring thickness when the approximate thickness is not well known 
Unless otherwise specified, FILMeasure will determine a film’s thickness 
by finding the best answer within about 1000 Å of the initial (user 
supplied) value.  If the approximate thickness of the film is not known to 
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better than about 1000 Å, then the Grid method or the Fourier 
Transform method of determining approximate thickness may be 
applied.  See “Editing Film Structures” for more details. A Fast Fourier 
Transform analysis technique is also available. See page 47 for more 
information.  

Measuring photosensitive films 
For layers such as unexposed photoresist that can not be exposed to 
short-wavelength light, a filter may be inserted in the slot on the light 
source.

Troubleshooting 
Incorrect or unreasonable measurement results can be caused by a 
number of different factors.  Below are listed some of the more common 
symptoms of and solutions for poor measurement results.  In all cases it 
has been assumed that the user has read the “Measurement 
Assumptions” section listed above, and that each criteria has been met. 

Case #1: No oscillations, or portions of oscillations, are present in the 
measured reflectance spectrum.   
There can be several causes of this.  The simplest is that the film may 
just be very thin (<200 Å).  Also, if the film is very rough, non-uniform in 
thickness over the measurement area, or has a graded interface, it may 
not support coherent optical interference, and thus it may not be able to 
be measured.  Another cause of no oscillations can be an improper 
baseline measurement, so usually the first step when no oscillations are 
seen is to carefully retake the baseline. 

Case #2: The measured reflectance spectrum has periodic oscillations 
across the entire screen, but its minima and maxima do not match 
up with the calculated reflectance.   
The most common cause is that the initial thickness guess was 
considerably different than the actual film thickness, and due to the 
constraints on possible thicknesses, FILMeasure was not able to look for 
an answer in the region of the actual thickness.  To understand this, it 
helps to know that the number of oscillations on the screen is 
proportional to the film thickness.  For example, if the measured 
spectrum has roughly twice the number of the oscillations that the 
calculated spectrum has, then the measured film is roughly twice the 
thickness of the calculated thickness.  Using this information, the initial 
thickness guess and the thickness constraints can be set more 
appropriately in the Edit Structure dialog box.  Another possible cause 
is found in case #3 (incorrect dispersion). 
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Case #3: Two or more different, but nearly the same, thickness readings 
are obtainable from the same measurement location.   
When this occurs usually the measured and calculated spectra match 
somewhat, but not very well across the entire spectra (i.e., the 
measured and calculated spectra match only over a small wavelength 
range and then gradually walk off one another outside this wavelength 
range).  When thickness is the only value being measured, this is 
normally caused by the refractive index of the measured layer not 
matching that used by FILMeasure, especially when the film is greater 
than one micron thick.  Unless more accurate index values can be 
obtained, the best way to solve this problem is to restrict the wavelength 
range used in the analysis. 

Case #4: Not all of the measured spectrum display oscillations. 
Some regions of the spectrum are strangely curved (thickness greater 
than 1 micron).  This can be a symptom of non-uniformity in thicker 
films.  In this case simply restrict the wavelength range used in the 
analysis. 
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4 Advanced Features 

Fast Fourier Transform Thickness Only Mode (FFT TO mode) 
The FFT TO mode tends to be more robust when measuring very thick 
films or thick multi-layer stacks, where the total thickness is greater than 
5 microns. 

To activate FFT TO mode, select the select Enable FFT Thickness 
Only located on the Layers tab in the Edit Structure box. 

 
Figure 4.1: The main FILMeasure window shows a split screen with the 

measured spectrum on the top graph and the FFT spectrum on the bottom 

graph. 

In FFT TO mode, instead of matching the measured reflectance 
spectrum with a calculated reflectance spectrum, FILMeasure identifies 
the peaks in the FFT Spectrum and uses them to compute the layer 
thicknesses. The number of possible FFT peaks is n*(n+1)/2 where n is 
the number of layers. Thus, for a two layer structure, we expect to see 
three peaks in the FFT spectrum.  

Figure 1.1 shows the screen just after measurement of a two layer stack 
using FFT TO Mode. The upper graph shows a blue curve representing 
the reflectance spectrum of the sample. The lower graph shows a blue 
and red FFT spectrum. The blue FFT spectrum is computed from the 
measured reflectance. The red FFT spectrum is computed from the 
theoretical reflectance spectrum of a layer stack with the measured layer 
thicknesses. The small side lobes visible on either side of the two tall 
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peaks are artifacts of the FFT process and can generally be ignored. The 
only time the side lobes will cause a problem is if a weak peak from a 
multi-layer sample is very close to a much stronger peak. If this case 
occurs FILMeasure may lock onto one of the side lobes by mistake and it 
may not be possible to measure the layer thickness associated with the 
weak peak. Reducing the Constraint and/or increasing the guess for the 
thickness for the layer with the weak peak may be helpful in getting 
FILMeasure to lock onto the weak peak. If the peak is too weak to 
reliably measure it is best to change the layer structure definition so that 
the layer corresponding to the weak peak is eliminated. 

Along with the measured layer thicknesses, the Results Text Box also 
displays the goodness of fit (GOF). More information about the GOF is 
given below. 

Discussion of GOF:  

A perfect match between measured and theoretical FFT spectra will 
result in a GOF of 1.0. To insure accurate results the user may set a 
minimum acceptable GOF value by entering a number between 0 and 1 
into GOF Error on the Constraints Tab in Edit Structure. A warning 
message will be displayed after each measurement where the GOF falls 
below the user-specified GOF Error. If the GOF is less than 1.0 there 
are several possible causes as follows: 

 a) Nonuniformity – Any variation of layer thickness within the 
measurement spot will result in a reduction in the FFT peak heights. In 
order to permit easy visual interpretation of the FFT results FILMeasure 
always scales the amplitude of the red curve so that it matches the blue 
curve. However, if the scaling factor is not 1.0, FILMeasure reports a 
reduced GOF even if the red curve appears to exactly match the blue 
curve on the screen. 

 b) Incorrect Structure Definition – If the refractive index of one 
or more layers in the structure is different from what is described in the 
layer structure, the FFT peak amplitudes in the blue curve will not match 
the peak heights in the red curve. The software will attempt to scale the 
red curve, but if there is more than one FFT peak present, the scaling 
will only result in one correct peak height. If you wish to view the impact 
of changing the refractive index of one or more layers, simply change 
the refractive index in the Edit Structure dialog box and click Analyze 
(ReAnalyze). If there is only a single layer you will notice that the GOF 
will change, but the red curve should not change much. If there are 
multiple layers in the structure you will notice that the relative peak 
heights in the red curve will change when you click Analyze. 

 c) Graded Interfaces – The amplitude of the peaks in the FFT 
spectrum depends on both the size of the change in refractive index at 
each interface in the layer structure and the sharpness of the interface. 
In many common samples you will find that there is some degree of 
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layer intermixing at the interface, leading to a weaker than expected 
reflectance at that interface. The FFT peak(s) associated with the 
intermixed interface will suffer a reduced amplitude and in severe cases 
the peaks may disappear entirely. 

Contact Probe – Template Mode 
Contact Probe Template Mode can be activated by selecting 
Setup>Contact Probe Mode>Activate Template Mode. When this 
option is selected, options will appear on the bottom right corner of the 
main screen allowing the user to Edit Template and Measure to 
Template. Saved templates can be selected from the Template: pull-
down menu. 

 

Figure 4.2: To activate Template Mode, select Setup>Contact Probe 
Mode> Activate Template Mode. 
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Template Window 
While Template Mode is activated, if Measure to Template is 
selected, the Template Window will display with the saved template 
loaded (selected from the Template: pull-down menu). 

 

 

Figure 4.3: The Template Window appears when the Measure to Template 

Button is selected. 

1. The Measurement Legend is displayed on the Template 
Window when Alarms are activated. 

2. The outline represents the template pattern and shape. 
3. When Alarms are not activated, points that have been measured 

are indicated by a blue dot with the measured thickness values. 
Points that fall outside the thickness range as specified in the 
Alarms section of the Edit Structure dialogue are marked 
according to the Measurement Legend. All points must be 
measured in the numbered order given on the pattern. 

4. The next point to be measured is indicated by a blinking dot. All 
points must be measured in the numbered order given on the 
pattern. 

5. Points that have not been measured are indicated by a blue dot. All 
points must be measured in the numbered order given on the 
pattern. 

6. Edit Last Measurement allows the user to choose the best 
measurement for the last measured point. 

7. Selecting this closes the Manual Template window. 
8. Selecting this removes the thickness value of the last measured 

point, so it can be re-measured. 
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9. Once all measurements have been made, the user can accept the 
measurement results, save the template with measurements, or 
print the template with the measured values. 

Measuring to a Template 
Measurements are continuously taken for the active point while the 
probe is depressed on the sample. Removing the probe from the sample 
will stop measurement for the active point.  

Once measurement is stopped, the template will be updated with the 
measured thickness of the point. Points that are invalid or are outside of 
the thickness range specified in the Alarms section of the Edit 
Structure window will display as red dots. 

To accept the thickness and measure the next point, the probe can then 
be placed on the next measurement location. 

Editing Template 
Selecting Edit Template while Template Mode is activated will bring 
up the Template Structure window. This window allows the user to 
edit and create new templates by changing the template outline and 
moving, adding, or removing measurement points on the template.  

 

 

Figure 4.4: Template Structure Window. 

1. The Template Structure can be saved as a new structure, or 
changes can be saved. 
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2. Location of measurement points are indicated by blue dots and are 
labeled by the order in which they will be measured. 

3. The outline of the template can be changed to match the pattern of 
the sample. 

4. Selecting Move Outline allows the user to click and drag the 
corners of the polygon to create new shapes. Add Points, Remove 
Points, and Move Points allow the user to add, remove, and click 
and drag existing points, respectively. Points are added sequentially, 
and when points are removed, the measurement order is 
automatically renumbered. 

5. The name of the Template Structure is listed here, as well as the 
layer structure that is currently in use. 

6. Author, as defined by user login name, and structure modification 
date are indicated here. 

7. Clears all measurement locations on the template. 
8. OK closes the Template Structure box, retaining any changes 

made. Changes will not be permanently saved unless Save of Save 
As is selected. The Cancel button closes the Edit Structure box 
without retaining any changes. 

Software Overview for n and k Enabled Systems 
For users who have n and k enabled software, certain modifications to 
the standard FILMeasure software have been made to allow users to 
accurately determine the index of refraction and extinction coefficient of 
a film.  

 

Figure 4.5: Edit Structure>Layers window for n and k enabled systems. 
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Edit Structure > Layers: Measuring Optical Constants 
For n and k enabled users, n and k can be measured by checking the 
appropriate box on the right-hand side of the Layers field in the Edit 
Structure dialog box. When an optical constant is selected for 
measurement, Enable Robust Thickness Only and Enable FFT 
Thickness Only cannot be selected. 

In general, thickness values can be measured independently if the n and 
k of the layer are specified.  However, unless the thickness is extremely 
well known, n and k cannot be measured without also measuring 
thickness.  Also, unless the material is a dielectric (k=0), n and k must 
be measured together.  

As with most measurements, the uncertainty of the measured data 
increases as the number of simultaneously measured values increases.  
This is especially true here, as changes in d, n, and k can often affect 
the measured reflectance spectrum in similar ways.  Thus it is best to 
provide as much information about the film structure as possible. 

 

Figure 4.6: Edit Structure>Solver Options for n and k enabled systems. 

Edit Structure > Options: nk Model 
When measuring n and k for a film, the general dependence of these 
values upon wavelength must be specified. This dependence is 
determined y the type of material to be measured. For example, 
insulators, semiconductors, and metals all have a unique type of n and k 
wavelength dependence. Dozens of models for these different 
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dependencies have been proposed and used over the years. FILMeasure 
uses a few of the most versatile and accepted of these models. For 
insulators, the Cauchy model is used, for semiconductors, either the 
Amorphous or Bridge-Lorentzian model, and for metals, the Drude 
model. These models, and starting coefficients values, are selected 
automatically when a material is chosen for the Material lists in the 
Edit Structure dialog box. Other models may also be specified by 
selecting them from the nk Model box in the Options tab. 

Edit Structure > Options: Display Details 
When solving for n and k, the film values displayed in the Results 
Summary box of the main FILMeasure window will be the values 
determined for the wavelength entered here. 

Measurement Examples for n and k Enabled Systems 
Examples that describe the most common setups for index and thickness 
measurement are described in this section.  Use Figure 4.7 to find the 
proper example for your application. 

 

Note A:  Transparent substrates are considered to have a reflective backside 

unless the backside is specially prepared to absorb light incident from the 

frontside. 

Note B: These samples may require special preparation to reduce backside 

reflections in order to be measured accurately. 

Figure 4.7:  Selection tree for identifying the example for specific measurements. 
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Example #1:  Thickness and Optical Constants of Films on Opaque 
Substrates: Si3N4 on Silicon 

For this example we will demonstrate the measurement of Si3N4 on 
silicon but this type of measurement has an extremely broad range of 
applications, including the measurement of oxides, polysilicon, and 
optical coatings. 

Hardware: 

Any standard or rotating sample stage should work fine.  The sample 
frontside must be flat.  If the sample backside is not flat and parallel 
with the frontside, then the contact stage must be used. 

Step 1:  Select the film structure 
Select the film structure to be measured, in this case “Si3N4 on Si”, from 
the Structure: list box on the main screen.  If the structure to be 
measured does not exist, a new structure must be defined (see “Editing 
Film Structures”). 

 
Figure 4.8:  Example Edit Structure>Layers window for measuring the 

thickness, n, and k of films on an opaque substrate. 

Step 2:  Edit the film structure  
To edit the structure, click the Edit Structure button to open the dialog 
box.  Check to see that the film sequence matches that of the actual 
sample.  If not, different films can be selected.  Also enter your best 
guess for the thickness of the film to be measured.  Also check that 
thickness, n, and k of the Si3N4 layer are selected to be measured. 
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Figure 4.9:  Example Edit Structure>Options window for measuring the 

thickness, n, and k of films on an opaque substrate. 

Step 3:  Take a Baseline Measurement 
Take a baseline measurement by first clicking on the Baseline button 
on the main screen.  A dialog box will appear to step you through the 
process.  In the Take Baseline dialog box, make certain the Autoscale 
Integration checkbox is selected, and choose the reference material 
that will be used (“Si” in this case).  Then put the reference sample on 
the measurement stage and click OK.  A new dialog box will appear with 
further instructions for the dark measurement: remove the reference 
sample from the stage (or tilt the sample at an angle) and click OK.  

Step 4:  Make the Measurement 
Make the measurement by placing your sample on the stage and click on 
the Measure button.  FILMeasure will then acquire the reflectance 
spectrum and calculate the corresponding thickness.  If the 
measurement was successful, the calculated reflectance (the red line on 
the graph) will coincide with the measured reflectance (the blue line on 
the graph). 

If the measured and calculated spectra do not fall on top of each other, 
the resulting thickness, n, and k values are incorrect.  If the mismatch 
between measured data and calculation is only slight, the results 
reported will only be off by a small amount.  If the measured and 
calculated spectra match, but the results are implausible, there may be a 
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problem with the sample positioning and light collection.  Causes and 
corrective actions to improve the measurements are listed in Cases #1 
and #2 in the “Troubleshooting” section. 

 
Figure 4.10:  Measured and calculated reflectance spectra when measuring the 

thickness, n, and k of Si3N4 on silicon. 

 

Figure 4.11:  Calculated n and k curves may be selected from the Display list
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Example #2:  Thickness and Optical Constants of Films on Thick 
Transparent Substrates: MgF2 on BK7 

This type of measurement is typically applied to optical coatings on glass 
substrates, as well as anti-reflection coatings on various transparent 
substrates. 

Hardware: 
The contact stage must be used when measuring the thickness and 
optical constants of films on a thick transparent substrate (see Chapter 1 
for setup of the contact stage).  Use of the contact stage means that the 
front side of the sample must be flat. 

Step 1:  Select the film structure 
Select the film structure to be measured, in this case “MgF2 on BK7”, 
from the Structure: list box on the main screen.  If the structure to be 
measured does not exist, a new structure must be defined (see “Editing 
Film Structures”). 

 
Figure 4.12:  Example Edit Structure>Layers window for measuring the 

thickness, n, and k of films on a thick transparent substrate. 

Step 2:  Edit the film structure 
To edit the structure, click on the Edit Structure button to open the 
dialog box.  Check to see that the film sequence matches that of the 
actual sample.  If not, different films can be selected.  Also enter your 
best guess for the thickness of the film to be measured. 
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Figure 4.13:  Example Edit Structure>Options window for measuring the 

thickness, n, and k of films on a thick transparent substrate. 

Step 3:  Take a Baseline Measurement 
Take a baseline measurement by first clicking on the Baseline button 
on the main screen.  A dialog box will appear to step you through the 
process.  In the Take Baseline dialog box, make certain the Autoscale 
Integration checkbox is selected, and choose the reference material 
that will be used (“BK7” in this case).  Then put the reference sample on 
the measurement stage and click OK.  A new dialog box will appear with 
further instructions for the dark measurement: remove the reference 
sample from the stage (or tilt the sample at an angle) and click OK.  (In 
the case of a contact probe, place the probe on the baseline sample and 
click OK, and then remove the probe from the sample and click OK.) 

Step 4:  Make the Measurement 
Make the measurement by placing your sample on the stage and click on 
the Measure button.  FILMeasure will then acquire the reflectance 
spectrum and calculate the corresponding thickness.  If the 
measurement was successful, the minima and the maxima of the 
calculated reflectance (the red line on the graph) will coincide in 
wavelength with the minima and the maxima of the measured 
reflectance (the blue line on the graph).   

If the measured and calculated spectra do not fall on top of each other, 
the resulting thickness, n, and k values are incorrect.  If the mismatch 
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between measured data and calculation is only slight, the results 
reported will only be off by a small amount.  If the measured and 
calculated spectra match, but the results are implausible there may be a 
problem with the sample positioning and light collection.  Causes and 
corrective actions to improve the measurements are listed in Cases #1 
and #2 in the “Troubleshooting” section. 

 
Figure 4.14:  Measured and calculated reflectance spectra when measuring the 

thickness, n, and k of MgF2 on BK7 glass. 

 
Figure 4.15:  Calculated n and k curves may be selected from the Display list. 
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Troubleshooting 

Case #1: Poor matches between the measured and calculated 
reflectance spectra when measuring thickness and optical constants.   

There can be many causes of this problem, including those listed in Case 
#1 and Case #2 above.  Most commonly when a poor fit between the 
spectra occurs, it is because 1) the components of the film structure are 
not all included in the Edit Structure>Layers dialog box, 2) very 
inaccurate initial guesses for the film thickness(es) have been listed, 3) 
the optical constants listed in the Edit Structure>Layers dialog box 
are far from the actual optical constants in the material, or 4) the film 
being measured has properties that are not taken into account by 
FILMeasure.  Examples of these properties are graded interfaces, non-
uniform films, and voids. 

Case #2: Several different answers, or one unreasonable answer, are 
found when measuring thickness and optical constants, even though a 
good match is found between the measured and calculated reflectance 
spectra. 

This normally occurs when a large number of properties are being 
measured on a very thin film.  In general, the thinner a film is the less 
unique information that can be obtained from it.  To understand this, 
read Chapter 5 Theory of Operation.  To solve the problem, one must 
usually reduce the number of properties being measured. 

Hints for Improved Accuracy 

Roughness 
Slight amounts of surface or interface roughness may be present that 
will decrease the accuracy of the measurement of optical constants.  
Entering a value for or solving for roughness can account for this 
roughness, so that optical constants can be measured.  Generally, 
roughness is only present when the sample surface looks hazy at the 
measurement spot.  The fact that this haze can be seen means that 
there is scattered light.  (A perfectly smooth surface will scatter no light, 
and thus the measured spot will not be visible.)  Usually roughness less 
than 25 Å will not be visible and will have little effect on measurement 
results.  Roughness greater than about 200 Å will be extremely hazy to 
the point accurate measurement of optical constants will not be possible. 

Restricting the wavelength range of the analyzed reflectance spectrum 
Restricting the wavelength range can also be helpful in optical constant 
measurements if n and k are not accurately described over the whole 
wavelength range by a single model. If n and k are saved to file when 
measured with a restricted wavelength range, n and k versus 
wavelength data will only be saved for that specified range. 
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Creating and Editing Material Files 

Creating n and k files from a calculated spectrum (n and k enabled systems 
only) 

Files for n and k can be created directly from a calculated spectrum, 
where n and k are measured. Once a spectrum is analyzed, go to 
File>Save n and k to files… and save the files in C:\Program 
Files\FILMeasure\Material\. This will save your n and k files as a custom 
material which can be loaded into the layer structure. 

Creating new n and k files  
New n and k files can be created by going to Edit>Material Library… 
Clicking the New button will allow the user to define a new material file. 
Once clicked, while the Default Model is selected, the user can 
manually enter wavelength versus n or wavelength versus k values. 

The user can also select Custom Model. While this is selected, clicking 
on the Model… button allows the user to create n and k files using 
predefined mathematical models. 

Once completed, clicking Save As… will save the new file as a custom 
material for later use. 

Editing n and k files 
Existing material files can be edited by going to Edit>Material 
Library… There, the user can load a material file by clicking Open. 
Values can then be changed manually. Clicking Save will save the file for 
later use. 

Converting Microsoft Excel files into FILMeasure n and k files 
For wavelength versus n or wavelength versus k data saved in Excel 
(*.xls) format, the data can be directly saved as material files that can 
be read by FILMeasure. 

For both n and k files, the data should follow the format of figure 4.3, 
where the wavelength values, in units of nanometers, are in the first 
column, and the n or k values are in the second. Note that the version 
number (cell B1) refers to version of the file. For this cell, you can use 1. 
The material number (cell B2) refers to what material category the file 
corresponds to. The material categories (and their corresponding 
numbers) are: metal (1), semiconductor (2), insulator (3), photoresist 
(4), and other (5). By putting the correct value for the material number, 
the file will automatically be sorted into the correct category when 
selecting the material in the Edit Recipe window. 
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To save the file created by Microsoft Excel, go to File>Save As… For 
Save as Type: choose CSV (Comma delimited) (*.csv). For n files, 
save the file as “FILENAME.nnn”, and for k files, save the file as 
“FILENAME.kkk” (FILENAME represents the name you wish to call the 
file; note that quotation marks must be used to enclose the filename in 
Excel to force the extension to .nnn or .kkk). The file should be saved 
in the directory C:\Program Files\FILMeasure\Material. Clicking 
Save will save the material files for later use. 

 

     

Figure 4.3:  Creating n file using Microsoft Excel.  
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5 Theory of Operation 

Measurement Theory 
The F20 measures thin-film characteristics by either reflecting or 
transmitting light through the sample, and then analyzing this light over 
a range of wavelengths.  Because of its wave-like properties, light 
reflected from the top and bottom interfaces of a thin-film can be in-
phase so that reflections add, or out-of-phase so that reflections 
subtract.  Whether the reflections are in- or out-of-phase (or somewhere 
in between) depends on the wavelength of the light, as well as the 
thickness and properties of the film (e.g., reflections are in-phase when 
λ = (2*n*d)/i, where λ is the wavelength, n is the refractive index, d is 
the film thickness, and i is an integer).  The result is characteristic 
intensity oscillations in the reflectance spectrum (see Figure 5.1).  In 
general, the thicker the film, the more oscillations there are in a given 
wavelength range. 
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Figure 5.1:  Example of reflectance spectrum with oscillations. 

The amplitude of the oscillations is determined by the refractive index 
and extinction coefficient of the films and substrate.  Therefore, by 
analyzing the period and amplitude of these oscillations, the F20 can 
determine thickness and optical properties (n and k) of multiple thin-
films.
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Thickness Measurement Details 
Optical thin-film thickness measurements require the successful 
completion of two tasks: acquisition and then analysis of an accurate 
reflectance spectrum.  To determine film thickness, FILMeasure 
calculates a reflectance spectrum that matches as closely as possible the 
measured spectrum.  FILMeasure begins with an initial guess for what 
the reflectance spectrum should look like theoretically, based on the 
user’s input of a film structure for the sample.  Then FILMeasure varies 
the parameters it is solving for until the calculated reflectance spectrum 
matches the measured data.  Mathematically, this procedure is 
complicated by the fact that as the thickness of the films in the 
calculation is varied there can be many near matches.  Therefore, an 
approach that simply homes in on a solution by finding successively 
better approximations will not work unless the starting guess for optical 
thickness is within approximately 1000 Å if the actual thickness. 

In measuring thickness only, FILMeasure avoids homing in on a false 
solution by searching the entire acceptable thickness range to determine 
the thickness that gives the best possible match between the measured 
and calculated spectra.  The thickness range searched is determined by 
the initial guess for thickness together with the thickness constraint.  If 
no thickness is entered for an initial guess, FILMeasure will search the 
entire thickness range from 0 to 100 microns.  Since the time to find a 
solution is proportional to the range of thicknesses being searched it is 
beneficial to provide an initial guess for the thickness of the films to be 
measured. 

Optical Constants (n and k) Measurement Details 
Measurement of optical constants (refractive index and extinction 
coefficient, also called n and k) requires a simultaneous determination of 
film thickness.  The exception to this is for measurement of a bare 
substrate.  The approach used by FILMeasure to determine film 
thickness and optical constants is the same as that used to measure 
thickness alone, except that now n and k are also varied to optimize the 
match between calculated and measured reflectance spectra. 

Since n and k vary as a function of wavelength, it is necessary to solve 
for them at every wavelength.  For a completely unknown material it is 
not possible to do this using a reflectance spectrum only since at each 
wavelength only one know parameter (reflectance) is known and there 
are two unknowns (n and k).  However, n and k are not independent, 
but are related to each other via what is known as the Kramers-Kronig 
relation.  If n were known at all wavelengths, k could be computed 
solely from n.  Since it is only possible to measure n over a finite 
wavelength range, k cannot be computed directly from n. 
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In reality, however, there is plenty of data present from a single 
reflectance spectrum to determine both n and k simultaneously.  This is 
due to the fact that the refractive index at any given wavelength is not 
independent of the refractive index at adjacent wavelengths, but follows 
a smooth dependency that can be accurately modeled by a theoretical 
equation.  Furthermore, if there is an equation for refractive index it can 
be transformed using the Kramers-Kronig relations to yield k.  Thus, if 
the equation for refractive index has three adjustable parameters it is 
only necessary to adjust these three parameters, plus the thickness in 
order to match the calculated and measured spectra. 

Therefore, the measurement of n and k has been reduced to choosing 
an appropriate model for n and k as a function of wavelength and then 
adjusting the parameters in the model to obtain a good fit to the 
measured data.  FILMeasure uses different models depending on the 
type of material being measured. 

The parameter space being searched to find a solution is potentially 
quite large since it involves thickness plus the adjustable parameters of 
the model.  Furthermore, since there are many near-matches as the 
thickness in the model is varied, it is important to reduce the parameter 
space being searched.  This is done by homing in on the match closest 
to the initial guess.  This will only be the correct solution if the initial 
guess for thickness is within about ½ wavelength of the correct value.  
To permit more robust solution FILMeasure can search the entire 
constrained thickness range to determine the correct thickness before it 
begins solving for n and k.  This initial search feature is enabled by 
checking one of the appropriate search mechanisms in the Edit 
Structure>Options dialog box. 

F20 Hardware Operation 
The F20 performs two distinct functions: data acquisition and data 
analysis.  Data analysis specifics are discussed in Chapter 2 Software 
Overview.  In this section we describe how the F20 acquires accurate 
spectral reflectance data. 

Light is supplied by a tungsten-halogen bulb that generates light from 
approximately 375 nm to 3000 nm.  This light is delivered to and 
collected from the sample through a fiber-optic cable bundle and a lens.  
The intensity of the reflected light is measured at 512 different 
wavelengths with a spectrometer.  The F20 spectrometer uses a 
diffraction grating to disperse the light and a linear photodiode array to 
measure the light at the different wavelengths.  The photodiode array 
operates by integrating the current generated by light falling on each of 
the 512 pixels.  After a user-selectable integration time, the accumulated 
charge in each photodiode is read by the computer.  Because a longer 
integration time results in a larger charge, it is the integration time that 
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determines the sensitivity of the spectrometer.  Adjustment of the 
integration time is used to obtain the proper signal level.  Too short an 
integration time results in a weak, noisy signal, while too long of an 
integration time results in a saturated signal. 

The Baseline Measurement 
The baseline measurement allows the FILMeasure software to take into 
account the response inherent to the F20 reflectance measurement 
hardware.  It does this by measuring a reference sample and by taking a 
“dark” reading.  In any optical system there are many components 
whose characteristics vary with wavelength (e.g., the output of the light 
source and the sensitivity of the spectrometer).  However, when 
reflectance measurements are made, only variations in reflectance vs. 
wavelength due to the sample under test are of interest.  Therefore, 
FILMeasure must perform a calibration to determine the spectral 
response of the system.  This is done by making a measurement of a 
"reference" sample that has known reflectance characteristics.  Note that 
it is not necessary for the reference sample to be the same as the 
substrate upon which films to be measured reside.  The only purpose 
served by the reference sample is to permit calibration of the optical 
system.  For example, it is possible to use a Si wafer as the reference 
sample and then measure films on GaAs, InP, glass, plastic, etc. 

After the reference measurement is made a dark reading is taken.  A 
non-zero dark level is due to current leakage inherent to photodiodes, 
which causes each photodiode in the array slowly charges up even when 
no light enters the spectrometer.  Thus, in order to make an accurate 
measurement of the light entering the spectrometer, it is necessary to 
subtract this “dark” current contribution.  This is the purpose of the 
“dark” reading, which measures the magnitude of the dark current for a 
given integration time.  When a “dark” measurement is made, a 
spectrum is measured that represents the signal generated by the 
spectrometer when a sample of zero reflectance is measured.  To 
simulate a sample with zero reflectance during a “dark” measurement, a 
specularly reflecting sample can be held at an angle with the light source 
turned on, or in many cases the light source may simply be turned off 
momentarily during the dark measurement. 

Due to drift in the light source and temperature of the spectrometer 
electronics, it is a good idea to take a baseline periodically. 
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Appendix A How to Contact Us 
 

We welcome suggestions from our users on ways to improve our 
software and hardware.  Please send us any suggestions you may have 
for improvements in the manual or new features you would like to see in 
the software. 

We may be reached by phone at 858-573-9300, by fax at 858-573-9400, 
or by e-mail at support@filmetrics.com. 
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Appendix B Performance Specifications 

 
 Thickness Range Thickness Range 

when measuring 
n and k 

Accuracy1 Precision2 Stability3 

F20 150 Å to 50 µm 1000 Å to 5 µm 

F20-UV 30 Å to 20 µm 500 Å to 3 µm 
1 Å 0.7 Å 

F20-NIR 1000 Å to 250 µm 3000 Å to 10 µm 2 Å 1.2 Å 

F20-EXR 150 Å to 250 µm 1000 Å to 10 µm 1 Å 0.7 Å 

F20-HC 150 Å to 50 µm N/A 

The 
greater of 
0.4% or 

10 Å 

10 Å 10 Å 

F20-XT 1000 Å to 450 µm N/A 0.4% 2 Å 25 Å 

 

 

                                                 
1 Thermally grown SiO2 on Si (except for F20-XT: Si on SiO2 on Si). 
2 Standard deviation of 100 thickness readings of 500 nm SiO2 film on silicon substrate.  
Value is average of standard deviations measured over twenty successive days. F20-XT 
values are based on 7 µm Si on SiO2 on Si sample. 
3 Two sigma based on daily average of 100 readings of 500 nm SiO2 film on silicon, 
measured over twenty successive days. F20-XT values are based on 7 µm Si on SiO2 on 
Si sample. 
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Appendix C Application Note: Si3N4 
Theoretical Underpinnings  

The refractive index of a single layer film is related primarily to the depth 
of the minima found in the measured reflectance.  The reflectance at the 
interference fringe minima of a film deposited onto Si is zero when the 
refractive index is near 1.97.  The reflectivity at the fringe minima for a 
film with a refractive index of 2.00 is the same as that for a film with a 
refractive index of 1.94.  Therefore, it can be difficult to unambiguously 
determine the refractive index from a reflectance measurement.  
However, for most films the user knows that the refractive index is 
either always greater than or always less than 1.97 so there is no 
uncertainty.  Silicon nitride is one of the few rare films whose refractive 
index spans this critical range.  Fortunately, there is a solution for silicon 
nitride that allows us to determine which of the two possible refractive 
index values is correct.  This is done by measuring both n and k for 
silicon nitride and by realizing that silicon nitride with a refractive index 
larger than 1.97 has measurable absorption (non-zero k) at wavelengths 
less than 420 nm.  Thus, to get good results for n the widest possible 
wavelength range should be used (especially going down to short 
wavelengths) and the user should simultaneously measure both n and k. 

Discussion of Si3N4 n and k Measurement 
Silicon nitride is a dielectric material commonly used in semiconductor 
fabrication processes.  The refractive index of stoichiometric Silicon 
Nitride is 2.05 at 633 nm.  However, in practice the refractive index of 
deposited films can vary from 1.7 or less (films containing excess 
hydrogen or oxygen) to as high as 2.5 or more (Si rich films).  The 
measurement of n and k is complicated by the fact that this refractive 
index range (1.7 to 2.5) spans a critical range for films deposited on Si 
substrates.  In order to get an unambiguous result for measurement of 
n, the structure description should be set by choosing “Si3N4 (Si Rich)” 
as the material for the silicon nitride layer.  To confirm that the proper 
model is chosen, go to the options tab and note that the model 
displayed is “Si3N4”.  If the Si3N4 model is not displayed in the nk 
Model list and Si3N4 is not in the list of models, then newer software is 
required.  It is important that both n and k be measured simultaneously 
(put a check mark for n and for k in the Edit Structure>Layers dialog 
box).  When using the Si3N4 model the constraints for n and k should be 
set to large values (at least 5).  If the film is very thin (less than 50 nm), 
it may be necessary to set the material to “Si3N4” or “Si3N4-thin”, 
instead of “Si3N4 (Si Rich)”, to get reproducible results, but this should 
only be used as a last resort. 
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Step-by-step instructions for measuring silicon nitride on Si: 
1. Start FILMeasure and click the Edit Structure button. 
2. Set the material for the Medium to “Air”. 
3. Set the material for Layer 1 to “Si3N4 (Si Rich)”. 
4. Enter a guess for the layer thickness of the silicon nitride into the 

thickness box for Layer 1. 
5. Put check marks in the d, n, and k check boxes for Layer 1. 
6. Set the material for the Substrate to “Si”. 

 
Figure A.1: Settings for steps 1-6. 

7. Click on the Options tab. 
8. Click on Grid search for thickness under Solving Details. 
9. Make sure there is no check mark for Account for Back 

Reflections. 
10. Under Convergence Criteria, set the number of Maximum 

Iterations to “600” and set GOF greater than to “0.999”. 
11. Under Analyzed Data select Fixed Range and enter “From: 200” 

and “To: 1100”. 
12. Under Measurement Type select Reflectance. 
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Figure A.2: Settings for steps 7-12. 

13. Click on the Constraints tab.  
14. Set the constraint for d to 75%. 
15. Set the constraint for n to 5 and the constraint for k to 5. 
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Figure A.3: Settings for steps 13-15. 

16. Click Save As and give the structure a name. 
17. Follow the instructions in the manual for measuring dielectric layers. 
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Appendix D Optional Features 
D.1  Measuring Optoelectronic Devices 

VCSEL cavity resonance dips and distributed Bragg reflectors (DBRs) 
may be measured by selecting Opto Values from the Measure: list 
box.  To measure laser cavity resonance dips, select Cavity Dips from 
the Find list box.  This routine works by finding the wavelength that 
corresponds to the minimum reflectance in a pre-determined wavelength 
range.  The wavelength range that is searched can be restricted in one 
of two ways, which are selectable in the Cavity Dip Setup dialog box.  
The simplest way to restrict the wavelength range is to manually specify 
the range.  The second is to restrict the search to the range between the 
lowest wavelength above a given reflectance value and the highest 
wavelength above a second (usually identical) reflectance value.  The 
upper and lower limits of the search are displayed on the screen, along 
with the cavity dip location. 

The location of the center wavelength and the bounding reflectance 
minima of a DBR may be measured by selecting DBR Center from the 
Find list box.  The reflectance threshold for finding the mirror minima 
can be specified with the DBR Center Setup box.  This is especially 
useful when measuring multiple and convoluted DBR structures. 

D.2  Measuring Filters 
The cut-off wavelengths of high-pass, low-pass, band-pass, and notch 
filters may be measured by selecting Filters from the Measure: list 
box.  Filter measurements are made by taking appropriate reference and 
dark readings as described in the “Taking a Baseline” section, and 
clicking on Measure.  Measurement parameters are set on the main 
screen.  The wavelength range searched is restricted to that displayed 
on the screen, which is determined by the Set Up>Graph Limits dialog 
box from the menu bar. 

D.3  Correlation Function 
While it is always best to use accurate material index information, the 
FILMeasure software may be set up to correlate thickness results to 
targeted values using a binomial expression (y=Ax+B), when measuring 
films >1000 nm.  This option can be activated upon customer request.  
Contact Filmetrics for details.  If access to correlation parameters is user 
specific, you may wish to activate Set Up>Access Control… from the 
menu bar.  Supervisor and Engineer levels have access to the 
correlation parameters. 

Correlation parameters are stored with each structure.  Settings and 
activation are specific for each structure. 

To set up the correlation parameters, perform the following: 
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1. Enter the Edit Structure dialog box. 
2. Click the Edit Correlative Coef. button. 
3. Enter at least 3 measured and 3 target thicknesses.  For best results, 

enter many measurements at varying thicknesses. 
4. Click the Calculate Coefficients button. 
5. Click the Apply Updated Coefficients button to apply and close 

the dialog box. 

 
Figure A.4: Correlation Coefficients window. 

Measurements reported will be automatically adjusted.  A “Correlation 
Active” note will appear in the results box after an analysis has taken 
place.  Measured thickness values must be within the range of 
thicknesses specified in the correlation table.   

To deactivate the correlation parameters, go to the Correlation dialog 
box and deselect the Use Correlative Coefficients checkbox and 
press Close. 
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Appendix E Light Bulb Replacement 

        
* * Warning: * * Hazardous voltages are present within the unit.  Never 

attempt any maintenance without disconnecting the 
power cord.  

Step by step: 
1. Exit FILMeasure program and turn off your computer. 

        

2. Disconnect power cable from the back of the unit. 

 

3. Disconnect fiber optic cables from the front of the unit.   
4. Turn the unit over and remove the four recessed screws opening the 

two halves of the enclosure.  

        
* * Warning: * *  Caution, avoid touching any interior components, 

other than the lamp, lamp base, and housing. 

 

5. Loosen lamp set screw (counter clockwise to loosen). 
6. Insert new lamp fully into lamp housing.  Do not touch the lamp 

glass. 
7. Secure lamp with setscrew (clockwise).  Do not over tighten. 
8. Plug new lamp into the lamp power connector.  Do not test lamp 

with lid removed. 
9. Replace the unit’s top cover and screws.  Insert cord into wall supply 

and test light. 
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Appendix F Automation and Data 
Measurements can be automated and additional data analysis can be 
performed by user-supplied software that communicates with 
FILMeasure via use of an ActiveX object or by Dynamic Data Exchange 
(DDE). The ActiveX automation approach is the preferred method. The 
DDE automation is included only for backward compatibility with older 
software. An example ActiveX program written in Visual Basic 6.0 is 
located in Program Files\FILMeasure\ActiveXClientVB.  An 
example program illustrating how to use DDE with FILMeasure is located 
in the Program Files\FILMeasure\Client\Vc folder.   

Although the ActiveX example program is written in Visual Basic, the 
ActiveX communication can be done in any programming environment 
that supports ActiveX. The FILMeasure program exposes an ActiveX 
object called FMRemoteControl. The object has one function called 
.Execute(strCommand, intCancel). You pass in a string-based command 
in strCommand for FILMeasure to execute. The Execute function returns 
a string in response to the command. You can also check the result of 
the execute command separately using the property .Response. See the 
example program for information about how to instantiate the 
FMRemoteControl object. 

The syntax for each command includes a command keyword followed by 
a left parenthsis followed by one or two arguments followed by a closing 
parenthesis. If the command has no arguments (like GetGOF, for 
example) the parentheses are not needed. Some commands have 
arguments which are optional. Optional arguments are denoted with the 
use of {}.  

Some examples of valid commands are: 

ActiveSpectrometer(1) 

ActiveSpectrometer(1, 52DCB3F6C6E04622871DA36251D35DE4) 

Although all commands are listed below, commands that refer to 
measurement options not included with a particular system will not 
function.  For example, the commands dealing with OptoValues 
measurements are only available in FILMeasure versions containing the 
Measure: OptoValues option.  The commands understood by 
FILMeasure are as follows: 

ActiveSpectrometer(<arg1>,{<arg2>}) – Sets the current active 
spectrometer used for data acquisition to <arg1>. If the system has two 
spectrometers then a value of 3 may be used for <arg1> to activate 
both spectrometers simultaneously. USB versions may have more than 
one system connected and a GUID is required as <arg2> to specify a 
system box. If only one system is connected to the computer then 
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<arg2> is optional. To associate a GUID with a system serial number 
use the GetSystemGUID command. 

AnalyzeLayer – Equivalent to pushing the thickness analyze button.  
This command can be useful for testing DDE applications. 

AnalyzeOpto – Equivalent to pushing the OptoValues analyze button.  
This command can be useful for testing DDE applications. 

AuthenticateRefBac – Recovers previously stored Reference and 
Background spectra taken during baseline procedure. 

ContinuousAcquire(<arg1>) – If <arg1> is 1, it will start continuous 
acquire mode. 0 stops continuous acquisition. 

CopySpectrum – Copies currently displayed spectrum onto the 
clipboard. 

GetActiveSpectrometer({<arg1>}) - Returns the active spectrometer 
in the system with the GUID specified in <arg1>. <arg1> is optional if 
only one system is connected. 

GetGOF – Returns the GOF resulting from the last measurement. 

GetGOFThreshold - Returns the threshold used to calculate GOF. 

GetK – Returns the value of K resulting from the last measurement. 

GetLastBaselineDate - Returns the date the most recent baseline was 
performed. Returns 0 if no baseline exists. 

GetN – Returns the value of N resulting from the last measurement. 

GetNumSpectrometers({<arg1>}) – Returns the number of 
spectrometers in the system with the GUID specified in <arg1>. <arg1> 
is optional if only one system is connected. 

GetNumSystems - Returns the number of systems connected. 

GetRoughness(<arg1>) – Returns the measured roughness of the 
layer specified by <arg1>. 

GetSerialNumber({<arg1>}) – Returns the serial number of the 
system with the GUID specified in <arg1>. <arg1> is optional if only 
one system is connected. 

GetSystemGUID(<arg1>) – Returns the GUID of the system with the 
SystemID specified in <arg1>. SystemID must be a number from 1 to 
the number returned by GetNumSystems. 

GetSystemType({<arg1>}) – Returns the system type with the GUID 
specified in <arg1>. <arg1> is optional if only one system is connected. 

GetThickness(<arg1>) – Returns the measured thickness of the layer 
specified by <arg1>. 
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MeasureLayer – Equivalent to pushing the Measure button.  Returns 
the measured thickness of layer 1. 

MeasureOpto – Equivalent to pushing the OptoValues Measure 
button.  Returns the measured position of DBR or FP parameter 
specified. 

MeasureSpectrum – Equivalent to pushing the Spectrum Measure 
button.  Copies measured spectrum to the clipboard. 

OpenSpectrum(<arg1>) – Opens the spectrum whose name and path 
are specified in <arg1> and displays it on the graph.  Note that since 
quotation marks are not used, filenames cannot contain commas or 
parentheses. 

OptoDBRThreshold(<arg1>) – Sets the percentage threshold for DBR 
measurements to the value specified by <arg1>. 

OptoDBRThresholdMode(<arg1>) – use 0 in <arg1> to specify 
percentage of absolute reflectivity, use 1 to specify percentage of 
maximum reflectivity. 

OptoFPMeasurementMode(<arg1>) – use 0 in <arg1> to specify 
measuring based on a percentage of the maximum or absolute 
reflectivity, use 1 to specify measuring restricted by wavelength. 

OptoFPReflectanceLimits(<arg1>,<arg2>) – use <arg1> and 
<arg2> to specify the lower and upper reflectivity limits. 

OptoFPReflectanceThresholdMode(<arg1>) – use 0 in <arg1> to 
use the Absolute option, use 1 to use the Maximum option. 

OptoFPWavelengthLimits(<arg1>,<arg2>) – used to set the lower 
and upper wavelength limits. 

OptoMeasurementMode(<arg1>) – use 0 to select cavity dip, use 1 
to select DBR peak. 

PasteSpectrum – Paste spectrum from clipboard and graph it. 

PasteSpectrumRaw – Paste spectrum from clipboard, use reference 
and dark if selected, and graph it. 

QuitProgram – Exit FILMeasure program 

SaveCalculation(<arg1>) – Save calculated spectrum to file specified 
in <arg1>. 

SaveNK(<arg1>,<arg2>) – Saves n and k data to the name and path 
specified in <arg1> for layer <arg2>. Do not include the 3-digit 
extension. They will default to *.nnn and *.kkk. 

SaveRefVsTime(<arg1>,<arg2>) – Saves the current Reflectance vs. 
Time plot to the name specified in <arg1> for wavelength ID specified in 
<arg2>. <arg1> should only be a filename, do not include a path or the 



 

Appendix  81 

3-digit extension. It will default to *.vst. The saved filename and path 
will be displayed in the DDE box. 

SaveSpectrum(<arg1>) – Saves the current measured spectrum using 
name and path specified in <arg1>.  Note that since quotation marks 
are not used, filenames cannot contain commas or parentheses. 

SetDConstraint(<arg1>,<arg2>) – Sets the thickness constraint for 
layer <arg1> to +/-<arg2> percent. 

SetIntegrationTime(<arg1>,{<arg2>}, {<arg3>}) – Sets the 
integration time to <arg1> milliseconds for SpectrometerID <arg2>. For 
a single spectrometer system, the SpectrometerID is “1” and <arg2> is 
optional. USB versions may have more than one system connected. If 
more than one system is connected to the computer SpectrometerID, 
<arg2>, must be supplied and a GUID is required as <arg3> to indicate 
which system. If only one system is connected to the computer then 
<arg3> is optional. To associate a GUID with a system serial number 
use the GetSystemGUID command. If <arg2> is not supplied <arg3> 
must not be supplied. 

SetMat(<arg1>,<arg2>) – Set material for layer <arg1> to material 
<arg2>. 

SetMatMedium(<arg1>) – Set material for incident medium to 
material <arg1>. 

SetMatSubstrate(<arg1>) – Set material for substrate to material 
<arg1>. 

SetMode(<arg1>) – Set measurement mode to <arg1> (<arg1 must 
be either transmittance or reflectance)  

SetNA(<arg1>) – Set numerical aperture for measurement optics (only 
used in F40 systems). 

SetReferenceMaterial(<arg1>) – Set reference material to material 
<arg1> 

SetStartWavelength(<arg1>) – Set starting wavelength for data 
analysis to <arg1>. 

SetStructure(<arg1>) – Set structure to <arg1>.  Note Arg1 must 
exactly match the name of an existing structure in the list of structures.  
Valid structure names cannot contain parentheses. 

SetRecipe(<arg1>) – Set recipe to <arg1>.  Note Arg1 must exactly 
match the name of an existing recipe in the list of recipes.  Valid recipe 
names cannot contain parentheses. 

SetStopWavelength(<arg1>) – Set stop wavelength for data analysis 
to <arg1>. 
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SetThickness(<arg1>,<arg2>) – Sets the initial guess thickness of the 
layer specified by <arg1> to the thickness value specified by <arg2>.  
Returns the thickness value given in <arg2>. 

Start – Starts a Reflectance vs Time plot. Only support Reflectance 
vs.Time. 

Status – Verify the system is ready for commands. 

Stop – Stops a Reflectance vs Time plot. 

StoredSpectraAcquire({<arg1>},{<arg2>})  – Acquires a spectrum 
and stores into array in memory, where <arg1> is the argument for 
ActiveSpectrometer and <arg2> is a GUID to select a system box. 
Return value is SpectrumID that can be used to analyze or retrieve the 
spectrum. Before switching between spectrometers using <arg1> and 
<arg2> you must first execute ActiveSpectrometer at least once for each 
spectrometer after program startup. The ActiveSpectrometer command 
is slower than using StoredSpectraAcquire with <arg1> and <arg2> 
present, so it is preferable to use <arg1> and <arg2> to switch 
between spectrometers when doing high speed measurements. 

StoredSpectraAnalyze(<arg1>) – Analyzes a stored spectrum. 
<arg1> is the SpectrumID that determines which spectrum to analyze. 
Valid SpectrumID is from 1 to the number of stored spectra. 

StoredSpectraClear – Clear all stored spectra and free associated 
memory. 

StoreSpectraRetrieve(<arg1>) – Retrieve a stored spectrum and load 
into graph for possible analysis, saving to file, etc. <arg1> is the 
SpectrumID that determines which spectrum to retrieve. Valid 
SpectrumID is from 1 to the number of stored spectra. 

TakeBackground – Take a fresh background (sometimes called a dark) 
measurement. 

TakeRefBackground – Take a background measurement to be 
subtracted from the reference. You should normally execute 
TakeRefBackground each time you call TakeReference. 

TakeReference – Take a reference measurement. See 
TakeRefBackground. 

UseReference(<arg1>) – If <arg1> is 1 then Use Reference is 
activated. 0 deactivates (unchecks) Use Reference. 

UseBackground(<arg1>) – If <arg1> is 1 then Use Background 
(Subtract background or dark spectrum from measured data) is 
activated. 0 deactivates (unchecks) Use Background. 

 
. 
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